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Preface

This guide enables you to perform the following administration tasks: 

■ Managing user accounts

■ Managing business rules

■ Managing store sets

■ Managing reports

Audience
This guide is intended for Plan administrators and assumes that you are familiar with 
the following:

■ Security (access control, permissions, and authorization)

■ Retail domain metrics and terminology

■ Any company-specific policies, such as your naming conventions for merchandise 
and location hierarchies, naming conventions, and business practices 

Related Documents
For more information, the following documents are available in the Oracle Retail Plan 
Release 2.6.2 documentation set:

■ Oracle Retail Plan Installation Guide

■ Oracle Retail Plan Configuration Guide

■ Oracle Retail Plan Operations Guide

■ Oracle Retail Plan User Guide

Note: This guide describes the default implementation and default 
on screen labels. Your company may have customized the labels. In 
those situations, the screen labels on your user interface may not 
match the screen labels described in this guide.
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Customer Support
■ https://metalink.oracle.com

When contacting Customer Support, please provide:

■ Product version and program/module name

■ Functional and technical description of the problem (include business impact)

■ Detailed step-by-step instructions to recreate

■ Exact error message received

■ Screen shots of each step you take

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1
Managing User Accounts

Each person using the Oracle Retail application needs a user account with specific 
permissions, which determine what specific tasks that person can perform. This 
chapter includes the following sections:

■ Overview of User Management

■ User Account Roles

■ Managing User Accounts

■ Working with the User Management User Interface

■ Troubleshooting User Management Errors

Overview of User Management
The User Management utility enables you create, modify, and inactivate user accounts. 
User accounts enable you to provide user-specific access control permissions. 

There are two ways to manage user accounts: 

■ If you need to manage multiple user accounts all at once, use the Bulk Loader as 
described in the Plan Configuration Guide. This guide assumes that most of your 
user accounts have already been created, by means of the Bulk Loader.

■ If you need to add or modify one or two user accounts, use the User Management 
user interface as described in this chapter. 

User account permissions consists of a combination of specific roles (the scope of 
actions a user can perform) and hierarchy levels (the scope of business data a user can 
access). You can assign as many roles and hierarchy levels to a user account as 
necessary. 

About User Account Roles
A role specifies the scope of actions a user is allowed to perform. Plan comes with a set 
of default user account roles. If you need to add user account roles or modify the 

Important: If you are using Merchant Desktop and MicroStrategy, 
ensure that MicroStrategy has been installed and the RMIServer 
service is running before creating user accounts. For information 
about installing MicroStrategy, see the Plan Installation Guide. For 
information about Merchant Desktop and MicroStrategy user account 
integration, see Merchant Desktop Roles.
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actions available for user account roles, use the Bulk Loader XML files as described in 
the Plan Configuration Guide. 

About Hierarchy Levels
A hierarchy level defines the scope of business data a user has permissions to access. 
Hierarchy level consists of the combination of the following:

■ Location Hierarchy

■ Merchandise Hierarchy

About Assigning Roles and Hierarchies

If you assign the top level of both the merchandise and location hierarchies to a role, 
the user has access to all hierarchy levels for that role. 

If you want the user to have access to a specific merchandise-location hierarchy 
combination, you do so by specifying the roles and their associated hierarchies. For 
example, to assign permissions to submit for only Departments 314 and 327 for all 
locations, you would add two "submit" roles to the user account and assign a specific 
merchandise hierarchy to each role, as shown below:

PLAN_SUBMITTER - Merchandise Department 314 and Location Chain
PLAN_SUBMITTER - Merchandise Department 327 and Location Chain

User Account Roles
Plan ships with the following types of user account roles: 

■ User Management Roles

■ Plan Roles

■ Merchant Desktop Roles

User Management Roles
User Management roles enable you to add, modify, and remove user accounts. Review 
the list below to determine which User Management roles to assign a user. For 
example, you may want to assign one user the ability to create user accounts but 
assign a different user the ability to assign roles to those accounts. 

When a user who has been assigned User Management roles logs on, the User 
Management link on the main menu opens to the User Management utility. 

When a user who has not been assigned User Management privileges logs on, the User 
Management link opens to a password management dialog box. 

The application comes with the following User Management roles:

■ UM_USER_ADMIN – This role allows creating new user accounts. It does not 
allow assigning roles.

■ UM_ROLE_ASSIGNER – This role allows assigning roles to the existing user 
accounts. It does not allow creating or deleting user accounts. A person who uses 

Important: Setting the location hierarchy level below the chain level 
is not supported in Plan and may result in unpredictable behavior. 
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this role must understand the available merchandise and location hierarchies as 
described in About Hierarchy Levels.

■ UM_READ_ONLY_ADMIN – This role has privileges to view the list of users and 
their access permissions. This role does not allow adding, modifying, or deleting 
user accounts. 

Plan Roles
Plan comes with the following default roles:

■ PLAN_VIEWER

■ PLANNER

■ PLAN_SYSADMIN

■ PLAN_BIZADMIN

The following table describes the actions assigned to the initial set of roles:

* Users with PLAN_VIEWER roles can perform What-If calculations, but cannot 
save the results.

Merchant Desktop Roles
The hierarchy levels you assign to Merchant Desktop roles determine which hierarchy 
levels appear in enhanced reports. 

Having the enhanced reporting access set by a Merchant Desktop role  allows you to 
provide a more varied hierarchy coverage. For example, if people in many 
departments need access to enhanced reporting, you may want to give them more 
extensive access so that they can view data from other departments as well. 

Plan comes with the following Merchant Desktop roles:

■ MD_USER - Supplied by default. This role has read-only access to the view and all 
of the screens and components it contains. It also includes access to MicroStrategy 
reports.

Assign this role when you want to ensure that a user cannot make any changes 
and that they always receive updates from you. The merchandise-location 
hierarchy combinations you assign to this role determine what data appears in 
reports. 

As with the Oracle Retail applications roles, if you want a user to have access to 
multiple hierarchy combinations, you must add one role for each combination. For 
example: 

Table 1–1  Actions Assigned to the Pre-defined Plan Roles

Roles View Plans
Perform 
What-If

Edit/Create 
Plans

Submit and 
Publish Plans

Edit Business 
Rule Properties

PLAN_VIEWER Yes Yes* – – –

PLANNER Yes Yes Yes – –

PLAN_SYSADMIN Yes Yes Yes Yes –

PLAN_BIZADMIN Yes Yes Yes Yes Yes
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MD_USER - Merchandise Department 314 and Location Chain

MD_USER - Merchandise Department 327 and Location Chain 

Assign this role when you want to ensure that a user cannot make any changes 
and that they always receive updates from you. 

■ MD_POWER_USER - Supplied by default. This role has rights to personalize 
views, to create and remove screens and components, and to set individual 
parameters as allowed by the Merchant Desktop administrator. This role has 
access to MicroStrategy. Power users can copy and modify reports, but they 
cannot create reports.

Assign the power user role when you want to allow a user to make changes to 
their Merchant Desktop views. However, be aware that to ensure that their 
changes are preserved, you cannot automatically update some elements of their 
view or screens.

■ MD_ADMINISTRATOR - Supplied by default. This role has all rights to create, 
modify, and remove views, screens, components, and reports. This role has rights 
to set permissions for several parameters for power users.

The administrator role includes Web Professional privileges in Microstrategy - 
giving Adminstrators the ability to create reports using the Design Mode option in 
Microstrategy.   Design mode provides a more flexible and intuitive interface for 
creating and modifying reports than the Report Builder/Wizard functionality. 
Only administrators can create reports.

■ MD_REPORT_ADMIN - Supplied by Oracle Professional Services. This role has 
the same permissions as the MD_POWER_USER role plus MicroStrategy Web 
Professional permissions. This additional level of permissions allows Report 
Admins to create reports using the Design Mode option in Microstrategy.  Design 
mode provides a more flexible and intuitive interface for creating and modifying 
reports than the Report Builder/Wizard functionality.

Merchant Desktop and MicroStrategy User Integration
Because of the relationship between Plan User Management and the MicroStrategy, be 
aware of the following:

■ As long as the RMIServer service is running while you are creating user accounts, 
any Plan user account that you create that includes a Merchant Desktop role is 
automatically imported into the MicroStrategy users database.

As a result, use Plan User Management—not MicroStrategy—when managing user 
accounts.

■ Any changes you make to the MicroStrategy users database are not imported back 
to the Plan User Management user database. 

As a result, use Plan User Management—not MicroStrategy—when managing user 
accounts.

■ The user names that you create in Plan are case-sensitive, but the MicroStrategy 
user names are not.

For example, Plan treats "Admin" and "admin" as two unique user accounts. 
However, MicroStrategy treats them as the same user name and expects the same 
password for both of these user accounts.

If you add an account that has the same syntax but different case, the 
MicroStrategy password for that duplicate name is changed to match that of the 
new user. 
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As a result, avoid using upper-case and lower-case to differentiate between user names.
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Managing User Accounts
The User Management user interface enables you to add, modify, or remove user 
accounts. It also enables you to assign or modify the hierarchy levels assigned to a user 
account.

This section describes how you can effectively use the User Management user interface 
to manage the user accounts. It includes the following tasks:

■ Starting User Management

■ Changing the Password for the Default User Account

■ Creating a User Account

■ Assigning Roles and Hierarchy Levels to a User Account

■ Modifying User-Related Information

■ Modifying Role and Hierarchy Assignments

■ Removing User Accounts

■ Locking and Unlocking User Accounts

■ Expiring the User Accounts

Starting User Management
The User Management utility is available after you have installed the application, and 
it is accessible via the application main menu. 

To access the User Management utility for the first time, use the default user name and 
the associated password to log on to the application. This user account is a special 
account that provides access to all the User Management functions, and provided to 
you during the implementation. 

After you log on for the first time, you can create accounts for the additional users who 
need access to the User Management utility. In addition, you might want to change the 
root user account password. For more information, see Changing the Password for the 
Default User Account.

To manage user accounts:

1. Open a browser and enter the application URL, similar to the following:

https://servername:portnumber/plan/PlanLogin.do

The login screen appears.

2. Enter the root user name and password, and click Login.

The main menu appears with the User Management link.

3. Click the User Management link.

The Manage Users screen appears with a list of user accounts. For information 
about creating user accounts, see Creating a User Account. 

To quit User Management, click the Close link. The main menu appears.
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Changing the Password for the Default User Account
When you first access the User Management utility, you must use the default user 
account already set up for you. For security reasons, you must change the password 
associated to this account.

To change the password for the root account:

1. On the Manage Users screen, select Change Password from the Action list, and 
then click Apply.

The Set Root Password for user: root dialog box appears.

2. In the Old Password text box, enter the existing password, and in the New 
Password and Confirm New Password text boxes, enter the new password you 
want.

Reminder: Passwords are case-sensitive.

3. When the dialog box is complete, click Done.

You must use the new password the next time you attempt to log on using the 
root account.

Creating a User Account
You must create a user account for each user who needs access to the application. For 
each user account, you must then assign one or more roles that determine what 
products and features a user can access.

There are two ways to create user accounts: 

■ If you need to create multiple user accounts all at once, use the User Management 
Bulk Loader utility. For more information, see the section Understanding the User 
Management Bulk Loader Utility in the Plan Configuration Guide. 

■ If you need to add or modify one or two user accounts, use the User Management 
user interface as described in this section. 

To create a user account:

1. On the Manage Users screen, select Add New User from the Action list, and then 
click Apply.

The Add New User dialog box appears.

2. Complete the Add New User dialog box fields, as shown in the following table:

Table 1–2  User Account Elements

Field Description

User Name Required. The user name must be unique for each user. The user 
name is case-sensitive and can be up to 50 characters (letters, 
numbers, and symbols) long. For example, Buyer, buyer, and 
BUYER are all considered to be unique.

In general, avoid using upper and lower case to differentiate 
between accounts. This is especially important if you are using 
Merchant Desktop and MicroStrategy. For more information, see 
Merchant Desktop Roles. 
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3. When the fields are complete, click Done.

The Manage Users screen appears with the user name and related identifiers 
added. 

Now that you have created the user account, the next step is to assign the 
appropriate permissions as described in Assigning Roles and Hierarchy Levels to 
a User Account.

Password Required. The password is associated with the user name, and 
both are required to log on.

The password is case-sensitive and can be up to 50 characters 
(letters, numbers, and symbols) long. For example, Secret, secret, 
and SECRET are all considered to be unique.

First Name Optional, up to 50 characters. Helps you to identify the person 
assigned to a user name. For example, if your user names are 
generic labels (such as WomensBuyer001 andMensBuyer300), 
this information enables you to identify which employee is 
assigned to a specific user name. 

Last Name Optional, up to 50 characters. Helps you to identify the person 
assigned to a user name. 

MI Optional, 1 character. Helps you to identify the person assigned 
to a user name. 

Title Optional, up to 50 characters. Helps you to identify the person 
assigned to a user name. 

Employee ID Optional, up to 10 numbers. The employee ID is available for 
your internal use.

Table 1–2 (Cont.) User Account Elements

Field Description
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Assigning Roles and Hierarchy Levels to a User Account
Each user account must have one or more role associated with the applicable 
hierarchies. For information about roles and hierarchies, see Overview of User 
Management.

Important: If you are using Merchant Desktop, see Merchant Desktop Roles. 

To assign roles to a user account:

1. From the Manage Users screen, select the user account to which you want to 
assign roles.

2. From the Action list, select User Roles, and then click Apply.

The Role Assignment for username screen appears.

3. From the Action list, select Add Role Assignment, and then click Apply.

The Add Role Assignment dialog box appears.

4. From the Role list box, select the role you want to assign to this user account. For 
details on the default roles supplied with Plan, see User Account Roles. Note that 
your implementation may have additional customized roles as well.

5. For any business-related role (any role except for User Management roles) specify 
the hierarchy levels you want this user to be able to access. 

To navigate down the hierarchy, hover your mouse pointer over the right arrow in 
the hierarchy. Keep navigating until the target level appears, and then click it. 

Figure 1–1 Assigning Hierarchy Levels to the Role

■ To navigate down a hierarchy, use the right arrow.

■ To navigate up a hierarchy, use the left arrow.

6. After you have selected the role and any applicable hierarchy levels, click Done.

The Role Assignment for <username> screen updates with the role and hierarchy 
levels added.

If an error message appears instead, see Troubleshooting User Management 
Errors.

Note: You can only add user roles one at a time from the graphical 
user interface. For instructions on how to add multiple roles all at 
once, see information about the Bulk Loader as described in the Plan 
Configuration Guide.

Role Hierarchy

Business Rule Manager The hierarchy levels determine the items and pricing groups for 
which a user can view/update business rules.

Plan The entire location hierarchy is within the scope of every action.

Merchant Desktop The hierarchy levels determine which alerts can appear to a user and 
which data a user can view in reports.
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7. Repeat steps 3 through 6 to add as many roles as necessary. When you are finished 
adding roles, click Done to return to the Manage Users screen.

Modifying User-Related Information
Modifying user-related information involves changing the user name, password, first 
name, and last name. Typically, you would modify a user account in a situation where 
the required activities remain the same, but the employee has been reassigned to other 
tasks. 

If you want to change the permissions associated with a user account, see Modifying 
Role and Hierarchy Assignments.

To modify a user account:

1. On the Manage Users screen, select the user account you want.

2. From the Action list, select Edit Existing User, and click Apply.

The Edit User screen appears.

3. Change the field values as necessary.

4. Click Done.

The Manage Users screen appears with the updated information. Changes to the 
user account are effective the next time the user attempts to log on.

Modifying Role and Hierarchy Assignments
For each user account, you can do the following:

■ Add or remove roles

■ Change the hierarchy levels associated with a specific role

To modify a role:

1. From the Manage Users screen, select the user account whose roles or hierarchy 
levels you want to modify. 

2. From the Action list, select User Roles, and click Apply.

Note: If you assign different roles within the same hierarchy levels, 
the role with the most privileges takes precedence. For example, if you 
assign a read-only role and a power user role for the same hierarchy, 
the power user role for that hierarchy is used when the user logs on. 

Note: You can only modify user accounts one at a time from the 
graphical user interface. For instructions on how to modify multiple 
accounts all at once, see information about the Bulk Loader as 
described in the Plan Configuration Guide.

Note: You can only modify roles and roles assignments one at a time 
from the graphical user interface. For instructions on how to add 
multiple roles all at once, see information about the Bulk Loader as 
described in the Plan Configuration Guide.
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The Role Assignment for <username> screen appears. 

3. From the Action list, select User Roles, and click Apply.

Do any of the following: 

4. When the screen reflects the changes, click Done.

The change take effect the next time the user logs on.

Removing User Accounts
Removing an user account  enables you to remove the user from the list. You may 
want to remove an user account when the assigned user moves to a different position 
or no longer needs access. The removed users can not be re-activated.  

When you remove a user account, that account is preserved in the database for reports 
and historical data. Use caution when removing a user account.

To remove a user account:

1. On the Manage Users screen, select the user accounts you want to remove.

2. From the Action list, select Remove User, and then click Apply.

A confirmation dialog box appears.

3. Click Yes to remove the user account.

The user account is removed from the list. If anyone attempts to use this account, 
the login will fail.

To Do this

Assign a role 1. From the Action list, select Add Role Assignment, and then click 
Apply. For a list of available roles, see User Account Roles. 

2. On the Add Role Assignment dialog box, select a role and its 
associated hierarchy levels, and click Done.

Change the 
hierarchy levels

1. Select the roles for which you want to change the hierarchy levels. For 
information about hierarchy levels, see About Hierarchy Levels.

2. From the Action list, select Edit Role Assignment, and then click 
Apply.

3. On the Edit Role Assignment dialog box, select the new hierarchy 
levels. (Alternatively, you could select a new role and keep the 
hierarchy levels.)

Remove a role 1. Select the roles you want to remove. 

2. Form the Action list, select Delete Role Assignment, and then click 
Apply. The role is removed immediately.

Caution: There is no undo, and there is no confirmation dialog box. 

Important: Removing a user account is permanent. There is no undo 
function. If you decide later that you need this account, you must 
create a new one. 

If you simply want to remove access to a product or to an area of the 
hierarchies for a specific user account, see Modifying Role and 
Hierarchy Assignments. If you want to reassign a user account to 
another person, see Modifying User-Related Information.
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Locking and Unlocking User Accounts
Use the Lock and Unlock Accounts features to control user access to the application. 
Locking an user account restricts access to the software temporarily, and the account 
can be unlocked with all the access privileges assigned to the user restored.

To lock a user account:

1. On the Main Menu, click the User Management link.

2. On the Manage User screen, click the check box next to the user account you want.

3. From the Action list, select Lock Account, and then click Apply. 

A confirmation dialog box appears.

4. Click Yes.

To unlock a user account:

1. On the Main Menu, click the User Management link.

2. On the Manage User screen, click the check box next to a locked user account you 
want.

3. From the Action list, select Unlock Account, and then click Apply. 

A confirmation dialog box appears.

4. Click Yes.

Expiring the User Accounts
Use the Expire User Account feature to force the user to reset the password associated 
with the user account. The user must now set up a new password, before logging on to 
the application. 

The expired user account can be re-activated by the user by reseting the password 
associated with the user account.

To expire the user account:

1. On the Manage User screen, click the check box next to the user account you want.

2. From the Action list, select Expire User Account, and then click Apply.  
A confirmation dialog box appears.

3. Click OK to expire the password for the user account.

Note: An user account gets locked after a specific number of 
attempts to log in to the software. Use the Unlock Accounts feature to 
unlock the accounts. Users will then need to change their passwords 
to log in to the software.
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Working with the User Management User Interface
The User Management user interface enables you work with the user accounts you 
have created as follows: 

■ Sorting Columns

■ Rearranging Columns

■ Hiding Columns

■ Printing and Exporting User Account Information

Sorting Columns
You can sort the data displayed on the following User Management screens:

■ Manage Users

■ Role Assignments for username

To sort the user and user roles data displays:

1. From the Action list, select Sort Table, and then click Apply.

The Customize Table dialog box appears.

2. On the Sort Table tab, enter a sort criteria in the following manner:

a. Select a column from the first list box. 

This column becomes the primary sort column for the data display.

b. For that column, select a sort order, either ascending order (A - Z or 1 - 10) or 
descending order (Z - A or 10 - 1).

c. If you want to sort the data by additional columns, select a column and sort 
order for the remaining two list boxes.

3. When the list boxes and sort order reflect the way you want the data to be sorted, 
click Done.

The Customize Table dialog box closes, and the data display is updated to the sort 
order you selected. The sort order remains in effect until you next change it.

Rearranging Columns
You can rearrange the columns on the following User Management screens:

■ Manage Users

■ Role Assignments for username

To rearrange the columns:

1. From the Action list, click Modify Columns, and then click Apply.

The Customize Table dialog box appears.

2. On the Change Columns tab, in the Visible Columns list box, select the column 
whose position you want to change.

Note: To remove one or more sort criteria, click *Select* from the list 
boxes.
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3. Click the up or down arrow until the column is in its target location.

4. Repeat steps 2 and 3 as many times as necessary.

5. When the Customize Table dialog box reflects your settings, click Done.

The Customize Table dialog box closes, and the screen updates with your 
modifications.

Hiding Columns
You can hide columns on the following User Management screens:

■ Manage Users

■ Role Assignments for username

To hide (or show) columns:

1. From the Action list, click Modify Columns, and then click Apply.

The Customize Table dialog box appears.

2. On the Change Columns tab, do one of the following:

■ To hide a column:

In the Visible Columns list box, select the column you want to hide.

Click the left arrow to move the column to the Hidden Columns list box.

■ To show a column:

In the Hidden Columns list box, select the column whose position you want 
to change.

Click the right arrow to move the column to the Visible Columns list box.

3. Repeat step 2 as many times as necessary.

4. When the Customize Table dialog box reflects your settings, click Done.

The Customize Table dialog box closes, and the screen updates with your 
modifications.

Printing and Exporting User Account Information
When you print or export information:

■ Only visible columns are printed or exported. 

For example, if you chose to hide some columns (see Hiding Columns), the data in 
those columns is not included in the print out or the Microsoft Excel file. 
(Likewise, data that is filtered out or hidden in a collapsed row is exported or 
printed.)

■ Information is printed or exported in the current sort order. (To change the sort 
order, see Sorting Columns).

To print or export user account information:

1. From the Action list on the screen you want, select Print or Export, and then click 
Apply.

The Print or Export dialog box appears with a reminder that only the visible data 
will be printed or exported. The dialog box also indicate the number of rows and 
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the columns, which helps you to estimate how long the print or export process 
will take.

2. Do one of the following:

Troubleshooting User Management Errors
This section enables you to troubleshoot the following user account management 
errors: 

■ Unable To Perform Request: System Error

■ User Cannot Log In

Unable To Perform Request: System Error
The following error message can occur in a variety of circumstances:

Unable to perform request due to system error

Solution
Perform the following: 

■ Verify that the network is not having problems. 

■ Verify that the User Management database is available.

User Cannot Log In
A user reports that their username and password combination is no longer working.

Solution
Log in problems are usually due to case-sensitivity issues. To solve this problem, 
perform the following: 

■ Make sure that the user has not selected the Caps Lock key.

■ If you have recently changed their Plan password or username, it is possible that 
Internet Explorer is storing the former password. This can occur when the only 
change in the user name or password is case.

■ If you added a Merchant Desktop account whose user name differs only in case to 
an existing user name, the MicroStrategy password for that "duplicate" name is 
changed to match that of the new user. See Merchant Desktop and MicroStrategy 
User Integration.

To Do This

Print the user data on the 
screen (not the screen itself)

Click Print and complete the resulting print dialog box as you 
normally would.

Export the data to a 
Microsoft Excel spreadsheet

1. Click Send to Excel.

2. On the resulting Save As dialog box, enter a file name and 
click Save. An Export Complete message appears along 
with the path and file name of the Excel file, and the Excel 
file opens.
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2
Managing Business Rules 

Business rules specify the constraints that an Plan uses when performing calculations, 
forecasts, and other automated processing. 

This chapter contains the following sections: 

■ About Business Rules

■ Plan Business Rules

■ Understanding the Business Rule Management User Interface

■ Locating Your Business Rules

■ Modifying the Business Rule Settings

■ Copying the Business Rule Settings

■ Removing the Business Rule Settings

■ Viewing the History of All the Business Rule Modifications

About Business Rules
Business rules are applied to items, not to the pricing groups. Instead, business rules 
apply for each item regardless of membership in a pricing group. When items in the 
same pricing group have differing out dates, target sell throughs, salvage values, and 
so on, the final value is derived by rules set during the implementation.

Within the Plan application, the relevant business rules are similarly applied to 
actualized and mock items. 

Note: Although business rules are applied to items instead of pricing 
groups, typically business rules are set at higher levels in the 
merchandise hierarchy than the item level.
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Plan Business Rules
The following table describes the business rules shipped along with the Plan 
application: 

Table 2–1  Plan Business Rules

Name Description

AUR_ADJUSTMENT_PCT The average unit retail discount percent. Used in the display 
of new plans.

Default Label: Average Unit Retail Discount Percent

Default Value: 12

ANNUAL_BASICS_PLAN_MIN 
 

Optional. The minimum annual receipt quantity. Used to 
calculate the minimum value for new basic items and to 
validate basic items. 

Default Label: Annual Basics Plan Minimum 

Default Value: 12

SAFETY_STOCK The additional time, in days, to stock an item so that it is not 
out-of-stock.

Default Label: Safety Stock

Default Value: 14

TOLERANCE_PCT The acceptable variance, expressed as a percent, from the 
Store Financial Plan.

Default Label: Tolerance Pct

Default Value: 0.1

OOS_VALID_DAYS_OF_MONTH Optional. List of days that are valid as out-of-stock days. 

Default Label: Out Of Stock Valid Days of Month

Default Value: 1,15

PRODUCT_GROUP_ATTR Indicates whether or not Product Groups are auto-generated 
or not. If auto-generated, also indicates which merchandise 
column is the source.

Default Label: Product Group Attribute

Default Value: None (not auto-generated)

STORE_QTY_LOW_THRESHOLD Indicates the lower threshold for Store-level quantities that 
will be flagged as a potential concern. Expressed as a 
percentage. Any store that deviates from the 
average-per-store by this value will be flagged as Yellow in 
the Assortment View - Store Quantities screen.

Default Label: Store Qty Low Threshold Attribute

Default Value: 50

STORE_QTY_HIGH_THRESHOLD Indicates the upper threshold for Store-level quantities that 
will be flagged as potential concern. Expressed as a 
percentage. Any store that deviates from the 
average-per-store by this value will be flagged as Red in the 
Assortment View - Store Quantities screen.

Default label: Store Qty High Threshold Attribute

Default Value: 75
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Understanding the Business Rule Management User Interface
This section provides an overview of the Business Rule Management user interface. 

To access the Business Rule Management utility:

■ From the main menu, click Business Rule Management.

The Business Rules screen appears.

Figure 2–1 Business Rules Screen

The Business Rules Manager screen has the following panels:

■ Filters Panel – enables you to quickly navigate to any hierarchy level.

■ Grid Panel – displays the business rules.

Business Rules Filters Panel
The Filters panel enables you to quickly navigate to any hierarchy. The Filters panel is 
collapsible; once you find the hierarchy you want, you can close the Filters panel to 
make more room for the display of your business rules.

To close the Filters panel, click the double left-arrow (<<) button. To later display the 
Filters panel, click the double right-arrow (>>) button. 

The following table describes the fields that appear in the Filters panel: 

Table 2–2  Business Rules Filters Panel Fields

Field Description

Merchandise and Location Sections

Browse Use the Browse button to navigate to the hierarchy level you want.
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Business Rules Grid Panel
The Business Rules Grid panel displays the business rules based on the filters that you 
have set up in the Filters panel. The panel displays a grid that provides information 
from the top level of both the Merchandise and Location hierarchy, including all the 
attributes. The following table describes the border and shading features used in the 
grid:

Locating Your Business Rules
Business rules may be set on one or more levels in the hierarchies. There are several 
ways to locate your business rules: 

■ Browsing Through the Hierarchies

■ Expanding the Hierarchies Within the Grid

■ Finding a Hierarchy Entity

Browsing Through the Hierarchies
The Business Rule Management user interface enables you to select a node in the 
Merchandise and Location hierarchies by using expandable menus. This section helps 
you to use the expandable menus to effectively navigate through the hierarchies.

To navigate through the hierarchies:

Find Specify the hierarchy level you want, and click Filter.

Attributes Section Select the attributes that you want to use to filter within the current 
hierarchy levels. 

■ To filter using no attributes, select the blank line.

■ To filter using all the attributes, select Any.

Show Rules Section

Higher levels with 
rules

Select this filtering rule to display inherited business rules (rules, set at 
the higher levels in the hierarchy, inherited by an item at a lower level).

Only filtered level Select this filtering rule to display the business rules at a specific level. 
The Business Rules screen displays the rules at the item level in the 
Merchandise and Location hierarchy. Rows that precede this level do not 
appear.

Set the table levels 
in the View option

Select this filtering rule to display the levels at which rule values can be 
updated.

Feature Description Indicates

Border Black border You can edit the value.

Gray border You cannot edit the value.

Cell color Green cell The rule value has been edited.

Normal cell The rule value has not been edited.

Text color Black text The rule value has been set at this level.

Gray text The rule value has been inherited.

Table 2–2 (Cont.) Business Rules Filters Panel Fields

Field Description
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1. On the Filters panel, under Merchandise or Location, click Browse. 

2. Move the mouse pointer over the right arrow, next to Browse, to navigate through 
the hierarchy levels.

3. Move the mouse pointer through each successive right arrow till you reach the 
hierarchy level you want.

The following figure shows an example of an expanded Merchandise hierarchy 
level:

Figure 2–2 Browsing through Hierarchies

4. Once you reach the level and node you want, click it.

5. Click the Filter button.

The Business Rules Grid panel (right pane) updates to reflect the hierarchy level 
you selected.

To traverse back up the hierarchy, move the mouse pointer over the left arrow of the 
selected hierarchy level, and navigate back to the hierarchy level you want.

Expanding the Hierarchies Within the Grid
To expand the hierarchies within the grid:

■ In the hierarchy grid, click the blue angle bracket next to the hierarchy level.

The grid now displays an additional column that contains the next level (for 
example, Department and all of its nodes Dept. 001, Dept. 002, Dept. 003, and so 
on). Repeat this step until you expand the hierarchy to the levels you want.

The following figure shows an example of an expanded merchandise hierarchy using 
this method:
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Figure 2–3 Expanding the Hierarchies

Finding a Hierarchy Entity
You can use the Find feature to navigate to a node (an entity on a hierarchy). Common 
examples of node identifiers are style, product, or store code, and so on. 

For example, on the Department level of the Merchandise hierarchy, some nodes might 
be Men’s Dept., Women’s Dept., Children’s Dept., Housewares Dept., Sporting Goods 
Dept., and so on.

To find a hierarchy entity:

1. On the Filters panel, under Merchandise or Location, click Find.

2. From the Find list box, select the level you want. For example, the Find list box for 
merchandise may include Style and Product. The Find list box for stores may include 
Region and Store.
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Figure 2–4 Finding a Hierarchy Entity

3. In the text box, enter the identifier for the node (for example, style, product, 
region, store, and so on). 

4. Click Filter.

If the node exists, it appears in the grid pane. Otherwise, a message appears 
indicating that the node could not be found.
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Modifying the Business Rule Settings
To modify the business rules:

1. Access the Business Rule Management utility. For more information, see 
Understanding the Business Rule Management User Interface. 

2. On the Business Rules screen, scroll horizontally to find the business rule you 
want.

Figure 2–5 Changing a value in a category

3. Modify the business rule value:

4. When you have changed the business rule values as necessary, click Save.

When you modify the business rule settings, any changes you make are inherited by 
the lower levels in the hierarchies.

Note: The rule values may be null only if that was set as the default 
value during implementation. To specify a null value, enter NONE.
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Copying the Business Rule Settings
You can copy the business rules settings from one (or more) hierarchy level/ attribute 
combination to another. 

To copy the business rule settings:

1. On the Business Rules screen grid, use the check box next to each rule to select one 
or more rule sets that you want to copy.

2. From the Action list, select Copy rule values, and click Apply.

The Copy Business Rules dialog box appears.

3. On the Copy Business Rules dialog box, clear the check boxes for the rule values 
you do not want to copy, and then click Copy.

4. On the Business Rules screen grid, locate and select the rule set you want to 
update with the copied values.

5. From the Action list, select Paste rule values, and click Apply.

The new business rule settings take effect immediately.

Removing the Business Rule Settings
When you delete a business rule setting,

■ The rule is not deleted from the Business Rule Management utility. Only the 
specified values (for a particular level) are removed.

■ The values in the inherited levels are replaced with the default values that were set 
during implementation.

To delete a business rule setting:

1. On the Business Rules screen grid, navigate to the rules that you want to delete.

2. To delete a single rule, select the rule you want, and click Delete.

Or

To delete multiple rules, select the rules you want. 
From the Action list, select Delete selected rules, and click Apply. 

Note: Any changes that you make are inherited by the lower levels 
in the Merchandise and Location hierarchies. There may be some 
restrictions on the rules that you can copy or paste.

Note: To remove the rule values, you must have the appropriate 
access privileges to edit the rule values. The following border shades 
indicate the access privileges for a rule:

■ A black cell border indicates that the rule value can be modified.

■ A gray cell border indicates that the rule value cannot be 
modified.
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3. Click Save.

Viewing the History of All the Business Rule Modifications
At any time, you can review the history of all the modifications made to a business 
rule. The number of prior weeks of history available in the application is determined 
during the implementation. 

To view the business rule history:

1. Access the Business Rules Management utility. For more information, see 
Understanding the Business Rule Management User Interface.

2. On the Business Rules screen grid, select the levels you want to review.

3. From the Action list, select View rule history, and click Apply.

The Business Rule History dialog box appears.

4. From the Rules list box, select the rule you want, and in the Changes between 
text boxes, enter the dates for which you want to view the history.

To view a business rule value that was in effect on a particular date, enter the date 
you want in both the text boxes.

5. Click View.

The Business Rule History screen appears with the history for the specified rule at 
the hierarchy levels. 

6. If you want to print or export the rule history, select Print or Export from the 
Action list, and then click Apply. 

7. When you are finished, click Done to return to the Business Rules screen.

About the Business Rule History Screen
The Business Rule History screen is organized by Merchandise and Location hierarchy 
levels and then by date, with the newest date at the top of each merchandise or 
location grouping and the oldest date at the bottom of each merchandise or location 
grouping. This enables you to view how a value was modified over time. 

On this screen, 

■ The Start Dt and End Dt columns show the time period for which the business rule 
and its value are effective. This can help you to determine if one or more weekly 
optimizations that have been affected by a particular business rule.

■ The User column displays the user name of the person who made the change.

Note: A pale green shade in the cell indicate that the rule values 
were removed.
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3
Managing Store Sets

The Store Set Management Utility enables you to view and change the store set 
settings. It also enables you to modify the stores and subsets included in a store set. 
This chapter describes the tasks that you can perform to manage the store sets and 
subsets. It includes the following sections:

■ Understanding Store Sets and Subsets

■ Accessing the Store Set Management Utility

■ Working with the Store Set Management User Interface

■ Managing Subsets

Understanding Store Sets and Subsets
A store set is a collection of stores and can be divided into one or more subsets. A 
subset contains a group of stores that share a characteristic, such as region, climate, 
fashion segment, ad designation, or a user-specific attribute.

Store sets are classified in the following manner:

■ Dynamic store sets are created and maintained by using filters. They are 
automatically updated whenever they are used, as the filters are re-applied or as 
the attributes change. You can change the store set type from Dynamic to Static to 
prevent automatic updates of the store set. If you manually assign a store to a store 
set, the store type is automatically set to Static.

■ Static store sets can be created manually or by using filters. They are not 
automatically updated; they can only be changed by deliberate user action.

For example, if stores are grouped in subsets that are defined by a distance range, and 
the range attribute filters are updated or a store's distant range changed, then the 
stores would then be re-assigned to new store sets.

Accessing the Store Set Management Utility
You can access the Store Set Management utility from the application main menu. 
Ensure that your user account includes the appropriate roles that are necessary to 
access the Store Set Management utility. 

To access the Store Set Management utility:

■ On the Main Menu, click Store Set Management. 

The Store Set Library screen appears, with a list of the stores you can access. This 
library provides a point of access to all the actions on the store sets.
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Store Set Library Grid
The following table describes the fields that appear on the Store Set Library grid:

Working with the Store Set Management User Interface
The Store Set Management user interface enables you to add, modify, or remove store 
sets, as also the associated stores or subsets. It also enables you to manage the subsets 
in a store set.

This section describes how you can effectively use the Store Set Management user 
interface to manage store sets and subsets. It includes the following tasks:

■ Creating New Store Sets

■ Copying the Selected Store Set

■ Renaming the Selected Store Sets

■ Merging the Selected Store Sets

■ Removing the Selected Store Sets

■ Viewing Other Store Sets

■ Printing and Exporting the Store Set Information

■ Sorting the User Account Information

■ Customizing the Columns

■ Finding Stores

Creating New Store Sets
Use the New Store Set feature to create new store sets. You can create new store sets to 
customize the store sets that you use.

To create new store sets:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears.

2. From the Action list, select New Store Set, and then click Apply.

A new store set named NewStoreSet is created and added to the Store Set Library.

For information on renaming the store set, see Renaming the Selected Store Sets.

Table 3–1  Fields that appear on the Store Set Library Grid

Field Description

Name Name of the store set.

# Subsets Number of subsets assigned to the store set.

Created By User ID of the user who created the store set.

Date Created Date when the user created the store set.

Last Used Date when the store set was last accessed by an user.

Type Type of the store set (Static or Dynamic).
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Copying the Selected Store Set
You can copy a store set to create a foundation for building a new store set. 

You can add subsets to the copied store set, or remove stores from the subset to create 
a new store set, defined by setting filters in the Filters tab.

To copy a selected store set:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears 

2. Select the check box next to the store set you want.

3. From the Action list, select Copy Selected Store Set, and then click Apply.

A new store set named Copy of store_set_name is created and added to the Store Set 
Library screen. 

For information on renaming the new store set, see Renaming the Selected Store Sets.

Renaming the Selected Store Sets
Use the Rename Selected Store Set feature to change the name of a store set. 

To rename a selected store set:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears.

2. Select the check box next to the store set you want.

3. From the Action list, select Rename Selected Store Set, and click Apply.

The Rename Store Set screen appears.

4. Enter the new name for the store set, and click Rename.

Note: You can copy only one store set at a time.

Note: Only letters, digits, a space, or "_" are the valid characters that 
are available for naming or renaming a store set or subset.
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Merging the Selected Store Sets
You can combine two existing store sets to create a new store set. The merged store sets 
continue to exist independently. You can merge only two store sets at a time.

To merge the two existing store sets:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears.

2. Select the check boxes next to the two store sets you want to merge.

3. From the Action list, select Merge Selected Store Sets, and click Apply.

The selected store sets are merged and displayed on the Store Set Library screen, 
with the name Store_Set_Name_1 and Store_Set_Name_2. 

For information on how to rename the new store set, see Renaming the Selected 
Store Sets.

To merge another store set with the merged store sets, repeat steps 2 and 3. 

Removing the Selected Store Sets
Use the Remove Selected Store Sets feature to remove a store set from the database. Once 
removed, you cannot retrieve that store set. 

To remove the selected store set:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears.

2. Select the check box next to the store set you want.

3. From the Action list, select Remove Selected Store Set, and click Apply.

The store set is deleted from the database.

Note: Merged stores sets are Static store sets.

Note: Only two store sets can be merged at a time. 

Note: The store sets created by a user can be deleted or removed 
from the application only by that user. The administrative also cannot 
remove the store sets created by another user.
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Viewing Other Store Sets
Use the View Other Store Sets feature to view all the store sets created by other users in 
the application. You can also search and add other store sets into your user login.

To view the other store sets:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears. 

2. From the Action list, select View Other Store Sets, and click Apply.

The View Other Store Sets screen appears.

3. Enter the user name in the User Name field 

Or 

Enter the store set name in the Store Set Name field.

4. Click Find.

5. The store set(s) that match your search criteria are displayed in the list.

The store set(s) appear in the library with the name of the user who created the 
store set, the store set ID, the date when it was created, the date when it was last 
used, and the type of store set. 

You can add this store set in the Store Set Library by clicking on Add Store Sets 
button on the top panel. The following figure shows the View Other Store Sets 
window with the search results.

Figure 3–1 View Other Store Sets Screen

To add the store set to the Store Set Library:

1. Select the check box next to the store set that you want to add to your Store Set 
Library.

2. Click Add Store Sets on the top panel of the screen.

Note: You can view all the store sets in the database. However, you 
cannot delete or modify any of the store sets created by the other 
users. 

Note: You can enter the user name and the store set name to find the 
store set.
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Printing and Exporting the Store Set Information
Use the Print or Export feature to print or export the information that appears on the 
Store Set Library grid. When you print or export the information:

■ Only the visible columns are printed or exported. For example, if you choose to 
hide some columns (see Customizing the Columns), the data in those columns are 
excluded in the output.

■ The information is printed or exported in the current sort order. (To change the 
sort order, see Sorting the User Account Information.)

To print or export the store set information:

1. From the Action list on the screen you want, select Print or Export, and then click 
Apply.

The Print or Export dialog box appears with a reminder that only the visible data 
(not the data in the hidden columns) will be printed or exported. The dialog box 
also includes a count of the rows and the columns. This can help you decide how 
long the print or export process will take.

2. Do one of the following:

Sorting the User Account Information
Use the Sort Table feature to sort the store set information that appears on the Store Set 
Library grid.

To sort the store set information:

1. From the Action list, select Sort Table, and click Apply.

The Customize Table dialog box appears.

2. On the Sort Table tab, enter a sort criteria in the following manner:

a. Select a column from the first list box. This column becomes the primary sort 
column for the data display.

b. For that column, select a sort order, either ascending order (A - Z or 1 - 10) or a 
descending order (Z - A or 10 - 1).

c. If you want to sort the data by additional columns, select a column and sort 
order for the remaining two list boxes.

Note: You can export the information in the Microsoft Excel (.xls) 
format.

Table 3–2  Printing and Exporting User Account Information

To Do This

Print the user data on the 
screen (not the screen itself)

1. Click Print. 

2. Enter the appropriate print parameters in the Print dialog 
box that appears.

Export the data to a 
Microsoft Excel spreadsheet

1. Click Send to Excel. The Save As dialog box appears.

2. Type a file name, and click Save. An Export Complete 
message appears along with the path and file name of the 
file, and the Microsoft Excel file opens.
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3. When the list boxes and sort order reflect the way you want the data to be sorted, 
click Done.

Customizing the Columns
Use the Modify Columns feature to customize (rearrange or hide) the columns that 
appear on the Store Set Library grid. 

To customize the columns:

1. From the Action list, select Modify Columns, and click Apply.

The Customize Table dialog box appears.

2. On the Change Columns tab, do one of the following:

3. When the Customize Table dialog box reflects your settings, click Done.

Finding Stores
You can search for a specific store in the application by using the Stores tab on the 
Store Set screen.

To find a store:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears.

2. Select the store set in which you want to search for the store.

The Store Set screen appears with three tabs - Subsets (default), Filters, and 
Stores.

3. Select the Stores tab.

4. From the Action list, select Find Store and click Apply.

The Find Store dialog box appears.

Note: To remove one or more sort criteria, click *Select* from the list 
boxes.

Table 3–3  Customizing Columns

To Do this

Hide a column 1. In the Visible Columns list, select the column that you want 
to hide.

2. Click the left arrow to move the column to the Hidden 
Columns list.

Show a hidden column 1. In the Hidden Columns list, select the column that you 
want to make visible.

2. Click the right arrow to move the column to the Visible 
Columns list.

Change the column order 1. In the Visible Columns list, select the column whose 
position you want to change.

2. Click the up or down arrow until the column is in its target 
location.
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5. Enter the ID for the store you want to find, and click OK.

The store you are searching for is displayed in color red at the top of the list.

Managing Subsets
A subset is a group of stores, grouped because of a similar attribute or characteristic. 
There can be many stores in a subset and multiple subsets assigned to a store set. 

This section describes how you can effectively manage subsets. It includes the 
following tasks:

■ Creating a New Subset

■ Adding Stores to a Subset

■ Renaming the Selected Subsets

■ Combining the Selected Subsets

■ Removing the Selected Subsets

■ Changing the Store Set Type to Static

■ Filtering the Subsets

■ Customizing the Table

■ Printing or Exporting Information

Creating a New Subset
Use the New Subset feature to create a new subset in a store set with different stores.

To create a new subset:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears. 

2. Select the store set in which you want to add a new subset.

The Store Set screen appears, with three tabs–Subsets (default), Filters, and 
Stores.

3. From the Action list, select New Subset, and click Apply.

The new subset is displayed in the grid with the name New SubSet. If you have 
already created a subset with that name, the new subset gets named as New 
SubSet1. You can change the name of the subset to an appropriate name. For 
information on how to change the name of the subset, see Renaming the Selected 
Subsets. 

Note: As a common user, the functionality of using Store Set 
Management is limited. You can only customize a table and print or 
export information.



Managing Subsets

Managing Store Sets 3-9

Adding Stores to a Subset
To add or replace the stores in a store subset:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears.

2. Select the store set to which you want to add the stores.

The Store Set screen appears, with three tabs: Subsets (default), Filters, and 
Stores.

3. On the Subsets tab, select the check box next to the subset you want.

4. In the text box to the right, enter the store IDs of the stores.

5. Click Add stores to Selected Subset.

6. If you want to replace the existing stores in the subset, select the Replace Existing 
Stores check box.

7. When finished, click Done.

Renaming the Selected Subsets
Use the Rename Selected Subsets feature to change the name of a newly added or an 
existing subset to an appropriate name. 

To rename a selected subset:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears. 

2. Select the store set that contains the subset you want.

The Store Set screen appears, with three tabs: Subsets (default), Filters, and 
Stores.

3. On the Subsets tab, select the subset you want.

4. From the Action list, select Rename Selected Subsets, and click Apply.

The Rename Subsets window appears.

5. Enter the new subset name in the Rename Subset field, and click Rename subset.

Combining the Selected Subsets
You can combine two or more existing subsets that belong to one store set. 

To combine two selected subsets:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears. 

2. Click the store set name and select the store set, which contains the two subsets 
you want to combine.

The Store Set screen appears, with three tabs: Subset (default), Filters, and Stores.

Note: You can combine only two subsets at a time.
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3. Select the two subsets that you want to combine by selecting the check box next to 
the two subsets.

4. Click Apply.

A confirmation message appears. When you combine two subsets, the store set is 
made static.

5. Click OK. 

The new subset is displayed on the grid, with the new name being a combination 
of the names of the two subsets.

Removing the Selected Subsets
Use the Remove Selected Subsets feature to remove subsets from the store set. Once 
removed, you cannot retrieve any information on the subset. 

To remove selected subsets from a store set:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears. 

2. Select the store set that contains the subset you want.

The Store Set screen appears, with three tabs: Subsets (default), Filters, and 
Stores.

3. Select the subset that you want to remove, and then click Apply. 

A confirmation message appears.

4. Click OK.

Changing the Store Set Type to Static
To change the store set type to Static:

1. On the Main Menu, click Store Set Management.

The Store Set Library screen appears.

2. Click the name of the store set.

The Store Set screen appears, with the Subsets tab displayed.

3. From the Action list, select Change Store Type to Static, and click Apply.

The store set type is changed to Static.
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Filtering the Subsets
You can create Dynamic store sets by using the Filters tab in the Store Set window. 
Dynamic store sets are created and maintained by using filters and are automatically 
updated whenever they are being used, as the filters are re-applied or as the attributes 
change. 

Use the Filters tab to create and delete filters. Filtering the subsets will enable you to 
move stores from one subset to another, based on the filter that you create and apply. 

To create a new filter:

1. From the Store Set Library, select a store set with at least two subsets.

2. Select the store set for which you want to create the filters. 

The Store Set screen appears with three tabs - Subsets, Filters, and Stores.

3. Select the Filters tab. 

The Filters tab appears.

4. From the If this is true: field values, select a field value that you want to use as a 
filter.

5. From the Operator list, select the operator that is associated with the column field 
value:

■ is equal to or is not equal to

■ is among or is not among

■ <, <=, =, >, or >=

6. Enter a variable, such as a numeric value or a state name, appropriate to the filter 
that you have chosen.

7. Click Add.

8. Click Apply Filter.

9. If the filter returns acceptable results, click Done to save the filter and exit.

To remove a specific filter:

1. Select the check box in front of the Clear field for the filter.

2. Click Clear.

To re-order the subsets:

1. Click Reorder Subsets.

The Reorder Store Sets window appears.

2. Select the subset that you want to move, and use the up or down arrows to change 
its position.

3. Click Reorder Subsets.

Note: To effectively use the Filter feature, you must have at least two 
subsets in a store set.
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Customizing the Table
You can change the display of the subsets listed within the Store Set screen by using 
the Customize Table option. For information on how to customize a table, see Sorting 
the User Account Information and Customizing the Columns.

Printing or Exporting Information
You can print the information displayed on the screen or export the information to a 
Microsoft Excel spreadsheet. For information on how to print or export data, see 
Printing and Exporting the Store Set Information.
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4
Managing Reports

The Merchant Desktop reporting utility uses the MicroStrategy Web Universal 
platform, and enables you to create reports required by your business. Users can then 
copy the reports you create, modify them, and save them to their own directories. This 
chapter describes the tasks you can perform, as an administrator, to manage the 
manage the reports.

This chapter includes the following sections:

■ About Merchant Desktop

■ Post-Installation Configuration

■ Administrative Tasks

■ Working with the Reports

■ Personalizing Merchant Desktop

■ Troubleshooting

■ Good Practices

Your access to MicroStrategy Web Universal is seamless. Once you log on to Merchant 
Desktop, you are logged on to MicroStrategy Web Universal platform.

When you access reports or graphs, you can also access the MicroStrategy help for 
more additional information on using the Merchant Desktop features.

About Merchant Desktop
Merchant Desktop is a reporting utility that helps you access the reports set up for the 
Plan application. It uses the Microstrategy Intelligence Server™ and the Web Universal 
platform, and provides features that help you export the report information in 
different formats, including the PDF format. It also helps you to subscribe to a report, 
at a specific interval.

Administrative Roles
The following administrative roles are available for Merchant Desktop:

■ MD_ADMINISTRATOR – Administrators have all access to the Merchant Desktop 
and MicroStrategy web professional privileges.

■ MD_REPORT_ADMIN – Report administrators have access to the personalization 
features within the Merchant Desktop and MicroStrategy Web Professional.
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Accessing Merchant Desktop
You can access the Merchant Desktop utility from the main menu of the Plan 
application. Ensure that your user account includes the roles that are necessary to 
access the Reports utility.

To access the Reports utility:

■ On the Main Menu, click Reports.

The Merchant Desktop screen appears, with a list of the features that you can 
access.

Post-Installation Configuration
MicroStrategy provides an export to PDF option that is not supported on all of the 
Merchant Desktop platforms. Once the Merchant Desktop is installed, you must 
ensure that the export to PDF is not available to users. In addition, you must also set 
up the history list option.

To set up the Export and History list options:

1. Start the MicroStrategy Desktop application.

The MicroStrategy Desktop application screen appears.

Figure 4–1 MicroStrategy Desktop Screen

2. Copy a user with the role of MD_ADMINISTRATOR from the Everyone group to 
the System Administrators group.

3. Open a new browser window, type in the Merchant Desktop URL, and log on as 
the user you just copied in the MicroStrategy Desktop.

The following screen appears:
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Figure 4–2 Merchant Desktop Screen

4. Click the Preferences button or link.

5. On the left-hand side of the screen, locate the Preferences Level menu, and then 
click the Project Defaults link.

6. Still on the left-hand side of the screen, locate the Preferences menu, and then click 
the History List link. 

7. Ensure that the Manually option is selected, and change the value of the number 
of reports you want to display for manipulation to at least 6 (See Figure 4–3).

Figure 4–3 Merchant Desktop - Update Confirmation Screen

8. Click the Apply button at the bottom left of the screen.

9. Again on the left-hand side of the screen, locate the Preferences menu, and then 
click the Export link. 
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The following screen appears (See Figure 4–4).

Figure 4–4 Merchant Desktop - Export Screen

10. Scroll down to the bottom of the screen, and clear the Enable export to PDF check 
box (See Figure 4–5).

Figure 4–5 Enable export to PDF Option

11. Click the Apply button at the bottom left of the screen.

12. Log out of Merchant Desktop.

13. Go back to MicroStrategy Desktop, and remove the user that you added in step 2 
from the System Administrators group.

Users will now have a history list of at least 6 reports (depending on the value you 
entered), and the Export to PDF option will not be available to users. 
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Administrative Tasks
Following is a high-level list of Merchant Desktop administration tasks. You can 
perform the following tasks after a successful installation of Merchant Desktop:

■ Managing user accounts - Depending on your implementation of Merchant 
Desktop and Plan, the user accounts may already be created for you by Oracle 
Retail professional services. You can use the User Management utility to add, 
modify, or inactivate (remove) user accounts. 

When users log on and no view is assigned to them, the following message 
appears:

Either the View you have been assigned is empty or you are not currently 
assigned a view. Please contact your administrator for assistance.

If you want to customize this message to include a name, phone number, or E-mail 
address or something else, see Updating the “Unassigned View” Message.

■ Managing views screens, and components - This task involves several procedures, 
and there are several ways to get started as explained in Getting Started with 
Views and Their Elements. After you have assigned views to users, see 
Understanding Updates to understand the effect of updates you make.

■ Managing reports - This task involves using the MicroStrategy Desktop or Web 
Universal application to create reports, or to modify any of the reports and graphs 
that are supplied with Merchant Desktop.

■ Managing desktops - This task involves making sure end user browsers are set up 
correctly. See the section Checking Your Merchant Desktop Browser Settings in the 
Plan User’s Guide. Use these settings on the administrative computer as well.

About Views, Screens, and Components
A view is the collection of screens and their components that appear on each user’s 
Merchant Desktop. You can create the views, screens, and components in any order, 
but it is helpful if you understand how they relate to each other:

■ Components are the building blocks of screens, and they contain the actual 
content. They appear as individual windows on each screen.

■ Screens are the building blocks of views, and they serve as containers for 
components.

■ Views are the “packages” that hold the screens (basically, a row of screen tabs). 
Views are what you deploy to Merchant Desktop users.

Below is a sample view that would be deployed to a user. It has five screens (Home, 
Forecasts, Markdowns, My Reports, and Reporting), and the Home screen has five 
components. The pencil buttons indicate that this view is for a power user.
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Figure 4–6 Merchant Desktop Screen Components

Updating the “Unassigned View” Message
You can customize the message that appears for users with no assigned views or no 
screen assigned to the view. 

To customize the message:

1. Retrieve the UnassignedUser.html file from one of the following locations, 
depending on which application server your site is using. If your application 
server is installed to a different location, use that path instead.

WebLogic:

../modules/MerchantDesktop/MerchantDesktop.ear/dashboard.war/html/UnassignedUse
r.html

WebSphere:

../WebSphere51/installedApps/servername/MerchantDesktop.ear/dashboard.war/html/
UnassignedUser.html

2. Modify the HTML using a text or HTML editor. 

An alternative is create a new HTML file using an HTML editor, but you must 
name it with the same name and capitalization: UnassignedUser.html

3. Copy the new or updated file to the same location in step 1.

The new HTML is available as soon as the file is copied.

Getting Started with Views and Their Elements
You can start working with the Merchant Desktop Views, and the associated elements, 
in one of the following ways:
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■ Copy the sample views, screens, and components supplied with Merchant 
Desktop and modify them as you want before you deploy them to users. See 
Modifying and Deploying Sample Views and Their Elements.

■ Create all of your own components, screens, and views. See Creating and 
Deploying Views and Their Elements.

Modifying and Deploying Sample Views and Their Elements
The Merchant Desktop module includes some sample views, screens, and components 
that you can use to create your own views, and then deploy them to the users. 

To modify the sample views (and the associated elements), and deploy them to the 
users:

1. If you haven’t already done so, create one or two test user accounts so that you can 
review the samples. See Creating a User Account.

2. Assign a sample view to one of the user accounts you just created. See Assigning a 
View to a User.

All sample views are named with a “pl - ” prefix. Sample views are provided for 
common roles in retail organizations, such as Buyers and GMMs.

3. Open a new Web browser window (do not open a browser window by selecting 
File > New > Window) and log on with the user account to which you just 
assigned the view.

4. Review the screens and components on this view to familiarize yourself with what 
you like and what you want to change.

5. If you are the only administrator and you are not concerned about preserving the 
samples as they are, you can modify them directly. This allows you to use the 
views as they are without having to assign newly created or copied screens, and to 
use the screens without having to add newly created or copied components.

If there are other administrators and you want to preserve the samples, make a 
copy of what you want to change first. To make a copy of a view, screen, or 
component, click the Copy link on the corresponding View, Screen, or Component 
Administration screen.

6. Modify and save each view, screen, or component as necessary. 

7. If you copied the components, add them to screens, and if you copied the screens, 
add them to a new or copied view. See the following:

■ Adding Components to a Screen

■ Adding Screens to a View

8. Test the view by assigning it to one of your test user accounts, opening a new 
browser instance, and logging on as that user. If you want to update a parameter:

a. Switch to the browser window where you are logged on as an administrator.

b. Make the change(s).

c. Switch back to the test user account browser window.

d. Click the changed view, screen, or component to see the change. 
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9. When you are satisfied with the view, assign it to users as explained in Assigning a 
View to a User.

10. After you assign views to users, see Understanding Updates to understand which 
updates affect power user accounts. Standard user accounts receive all 
administrative updates.

Creating and Deploying Views and Their Elements
If you want to start from scratch, here is a comprehensive and sequential list of all of 
the tasks involved in creating your own components, screens, and views and 
deploying them to users.

1. Create one or more components. See Creating a Component.

2. Create one or more screens. See Creating a Screen.

3. Add one or more components to each screen. See Adding Components to a Screen.

4. Create one or more views. See Creating a View.

5. Add one or more screens to each view. See Adding Screens to a View.

6. Assign each view to one or more users. See Assigning a View to a User.

All of these procedures assume you are logged on to Merchant Desktop with full 
administrative privileges.

Understanding Updates
After assigning the views to users, you may want to change the views by adding new 
screens, updating components, and so on. For standard users, the changes appear 
automatically the next time users click the affected element (view, screen, or 
component) or the next time they log on. Administrative updates do not affect the 
personalization done by the power users.

The following table summarizes the differences for standard users and power users:

Note: You must open separate instances of the browser by starting 
Internet Explorer. Opening a browser window via File > New > 
Window will not work because then two instances of the browser are 
sharing one Merchant Desktop session. 

Table 4–1  Understanding Updates

User account type Effect of administrative updates

Standard user 
(Read-only with no 
personalization privileges)

Users will automatically receive all of your changes the next 
time they click the affected element (view, screen, or 
component), or they will receive the changes the next time they 
log on.
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Forcing Updates
You can force updates to power users. However, you must be aware that forcing 
updates to power users overwrites all of the personalizations that they have made. 
Once you have forced an update, there is no way to retrieve the power user’s 
personalizations.

View Administration
The View Administration screen lists sample views supplied with Merchant Desktop 
(denoted by the “pl - ” prefix), and those created by you and other administrators. 
Views created by other administrators appear only when those administrators have 
selected the Allow All Administrators To Access check box for one or more views.

All of the views on this list can be assigned to one or more users. Use the View 
Administration screen as a starting place to do the following:

■ Create a new view

■ Edit a view

■ Copy a view

■ Delete a view

■ Assign a view to a user

■ Show or hide a view to/from other Merchant Desktop administrator view lists

View Administration Screen Fields
The following table describes the fields on the View Administration screen:

Power user 
(Personalization 
(read-write) privileges for 
views, screens, or 
components on a per 
parameter basis determined 
by administrative settings.)

After a power user customizes a view, screen, or component, the 
following administrative updates have no effect:

■ Updates to the changed screen, such as switching 
component positions or replacing components

■ Updates to the user view, such as the order of screens and 
setting the home screen. However, new screens are added to 
the end of the view.

Administrative updates to component parameters (such as 
show/hide title bar, HTML or HTTP source, etc.) are effective as 
long as the power user has selected the corresponding Use 
Default check box.

Caution: Forcing an update overwrites all personalizations that the 
power user has made. If you do need to force an update, remove the 
assigned view from the power user and then reassign it. 

Table 4–2  View Administration Screen Fields

Field Description

Create View Link Click this link to create a new view. The Create View screen 
appears.

Table 4–1 (Cont.) Understanding Updates

User account type Effect of administrative updates
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Creating a View
A view is a list of one or more screens that users are allowed to access. When users log 
on to Merchant Desktop, the view appears immediately after a successful login. For 
each view, you must select a skin (color scheme) and a home screen (the screen that 
will have the focus when users first log on).

Each user can be assigned only one view.

To create a view:

1. On the View Administration screen, click the Create View link.

The Create View screen appears.

2. Complete the Create View screen with the internal ID and description.

The user sees only the description. The ID and description appear on 
administration screens to help you distinguish between the different views that 
you create.

3. When the Create View screen reflects the setting you want, click Save.

Allow All Administrators 
To Access

Click this check box to share the view with other administrators.

This means that the view is available for copying, editing, or 
deleting by other administrators, and that when one 
administrator makes a change, all administrators receive that 
change. If multiple administrators are editing the same view at 
the same time, only the last-saved version is preserved.

ID Indicates the identification number (ID) assigned to the view. 
Each view ID is a link to the Edit View screen where you can 
modify which parameters users can edit, which screens appear 
in the view, and which skin (color scheme) will be applied to the 
view.

Views with the “pl - ” prefix are samples supplied with 
Merchant Desktop. To preserve these views for other 
administrators, copy them before modifying them.

Description This column displays the description text entered for the view 
(on the Create View or Edit View screens). To change the 
description, click the view name and enter a new description on 
the Edit View screen.

Copy Click this link to copy settings from an existing view to a new 
view ID. The Copy View screen appears.

Delete Click this link to remove this view from the Merchant Desktop 
system. 

There is no undo function. If you delete a view and later want to 
use it, you must recreate it. Deleting a view has the following 
effects:

■ Removes the view ID from the View Administration screen 
for you and all administrators.

■ Removes the view from all user accounts to which it is 
currently assigned. The next time affected users log on to 
Merchant Desktop, the unassigned view message will 
appear.

Assign Click this link to display the Assign View screen, where you can 
assign the selected view to, or remove a view from, one or more 
users.

Table 4–2 (Cont.) View Administration Screen Fields

Field Description
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The View Administration screen appears, and the new view appears in 
alphabetical order in the ID column. Before you and users can access it, you must 
assign screens to the view and then assign the view to users.

Copying a View
To create a new view by copying the settings from an existing view:

1. On the View Administration screen, click the Copy link for the view you want.

The Copy View screen appears.

2. On the Copy View screen, type a new view ID in the ID field.

3. In the View IDs Already In Use By You field, select the view you want.

4. Click Save.

Editing a View
To edit an existing view:

1. On the View Administration screen, under the ID column, click the view you 
want.

The Edit View screen appears.

2. Enter appropriate information in the fields, and click Save. The following table 
describes the fields in the Edit View screen:

Deleting a View
To delete a view:

1. On the View Administration screen, click the Delete link for the view you want.

The Delete View screen appears.

2. On the Delete View screen, review the users accounts that will be affected once 
you delete the view, and then click Delete.

Table 4–3  Fields in the Edit View Screen

Field Description

ID Identification number for the view.

Description Description text for the view.

Skin Select a skin (color theme) for the entire view.

Allow Personalization Click this check box to make the relevant field available for 
personalization.

Available Screens  
and  
Screens in Use

Use these lists to add or remove screens from the view.

To change the order of the screens, click a screen name and then 
click the Top, Up, Down, or Bottom buttons until the screen 
name is in the target position.

Caution: There is no undo function. If you delete a view and later 
want to use it, you must recreate it. In addition, deleting a view 
removes it from the entire Merchant Desktop system. This means that 
the view is deleted from all administrators as well as users.
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Assigning a View to a User
To assign a view to a user:

1. On the View Administration screen, click the Assign link for the view you want.

The Assign View screen appears.

2. On the Assign View screen, in the Available Users list, select the user you want. 

Press and hold the CTRL key to select multiple users.

3. Once you select the users, click the Assign button. The Users Assigned This View 
list now reflects the users assigned to the view.

An * (asterisk) preceding the user name indicates that user is already assigned a 
view. The assigned view appears in (parentheses) after the user name.

Adding Screens to a View
You can add as many screens as you want to a view. If you plan to add several screens 
to a view, consider making the screen names a short as possible. Each screen name 
appears on the tabs in the view, so making the screen names short will help to 
minimize the amount of horizontal scrolling users must do to see all of the screen tabs 
in the view.

To assign a screen to a view:

1. On the View Administration screen, under the ID column, click the view you 
want.

The Edit View screen appears. 

2. From the Available Screens list, select the screen you want.

To select multiple screens, click a screen name, press and hold the CTRL key, and 
click the names of the other screens you want.

3. Once you have selected the screen(s) you want to assign to this view, click the Add 
button.

The screen name(s) move to the Screens In View list. 

4. When the Screens In View list reflects all of the screens you want to add, click the 
Save button.

The View Administration screen appears.

Screen Administration
The Screen Administration screen lists sample screens supplied with Merchant 
Desktop (denoted by the “pl - ” prefix) and those created by you and other 
administrators. Screens created by other administrators appear only when those 
administrators have selected the Allow All Administrators To Access check box for 
one or more screens.

All of the screens on this list can be assigned to one or more views. Use the Screen 
Administration screen as a starting place to do the following:

Note: You can assign only one view to a user name. If a UserView1 is 
assigned to a user name and you then assign UserView2 to that same 
user name, UserView2 will become the default view the next time that 
user logs on.
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■ Create a screen

■ Copy a screen

■ Delete a screen

■ Edit a screen

■ Show or hide screens to/from users’ and other administrators’ lists of screens

Screen Administration Screen Fields
The following table describes the fields in the Screen Administration screen:

Creating a Screen
A screen is a container for components. It consists of a name and a layout.

Table 4–4  Screen Administration Screen Fields

Field Description

Create Screen Link Click this link to create a new screen. The Create Screen screen 
appears.

Allow Users To Add Click this check box to make the screen available to all users.

Allow All Administrators 
To Access

Click this check box to share the screen with other 
administrators.

This means that the screen is available for copying, editing, or 
deleting by other administrators, and that when one 
administrator makes a change, all administrators receive that 
change. If multiple administrators are editing the same screen at 
the same time, only the last-saved version is preserved.

ID Indicates the identification number (ID) assigned to the screen. 
Each screen name in the ID column is a link to the Edit Screen 
where you can modify all of the screen settings except for layout.

Screens with the “pl - ” prefix are samples supplied with 
Merchant Desktop. To preserve these screens for other 
administrators, copy them before modifying them.

Display Name The text that appears on the tab of each screen in the view.

Description This column displays the description text entered for the screen 
(on the Create Screen or Edit Screen screens). To change the 
description, click the screen name and enter a new description 
on the Edit Screen screen.

Copy Click this link to copy settings from an existing screen to a new 
screen ID. The Copy Screen screen appears.

Delete Click this link to remove this screen from the Merchant Desktop 
system. 

There is no undo function. If you delete a screen and later want 
to use it, you must recreate it. Deleting a screen has the 
following effects:

■ Removes the screen ID from the Screen Administration 
screen for you and all administrators.

■ Removes the screen from all user accounts to which it is 
currently assigned. The next time affected users log on to 
Merchant Desktop, the unassigned view message will 
appear.
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Depending on the layout, some screens can be assigned a maximum of six 
components. The one-column, two-column, and three-column open layouts can be 
assigned as many components as you want.

To create a screen:

1. On the Screen Administration screen, click the Create Screen link.

The Create Screen screen appears.

2. On the Create Screen screen, select a relevant screen type and layout, enter the 
screen ID, Display Name, and Description. For more information on screen types 
and layouts, see Screen Types and Screen Layouts.

3. Click Save.

The Screen Administration screen appears, and the new screen appears in 
alphabetical order in the ID column. You (and end users) cannot view it, however, 
until you add the screen to a view and then assign the view to a user.

Screen Types
Select one of the following screen types:

Table 4–5  Screen Types

Screen type Description

Standard The Standard screen is the most flexible of all of the screen types. 
For each standard screen, you can select a variety of pre-defined 
screen layouts, and you can add all of the components.

Performance The Performance screen is a special screen type that consists of 
the Filter Component.

The Filter component provides the merchandise, location, and 
time hierarchies by which you can dynamically update special 
reports and graphs. (You must create a series of filters for any 
reports or graphs that you want to interact with the Filter 
component.)

The Filtered Report and Filtered Graph components are 
designed to display the special reports and graphs and to 
interact with the merchandise, location, and period trees 
provided by the Filter component.

For each Performance screen, you can select a variety of 
pre-defined screen layouts, and you add any component. For 
example, even though only the Filtered Report and Filtered 
Graph components interact with the Filtered component, you 
might want to add a web site or news feed to the Performance 
screen.

Top/Bottom The Top/Bottom screen type provides a quick and easy way for 
users to access the top or bottom n percent of a variety of 
metrics. For example, you could select to view the bottom 20% 
of styles (from the merchandise hierarchy) by GM % across sales 
to date (STD) for Department N.

The Top/Bottom screen consists of four filter prompts 
(merchandise level, ranking, merchandise grouping, and time). 
After users have made a selection for each filter, they click the 
Execute Report button.

You cannot customize the Top/Bottom screen except for its 
display name and description. 
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Screen Layouts
Select one of the following layouts, which determines the number of components and 
where you can place them on screens. Note that there are two types of layouts in the 
list:

■ Fixed layouts - These layouts can contain from one to a set number of components. 
Their names begin with “Layout”, and the maximum number of components is 
the highest number in the thumbnail representations (see the table below).

■ Open layouts - These layouts can contain an unlimited number of components. 
They are named One Column, Two Column, and Three Column.

For example, Layout 8, which has three columns, can hold only three components (i.e., 
one row of three components). The Three Column layout, on the other hand, has three 
columns but can hold an unlimited number of components (i.e., there can be several 
rows of components).

The following table describes the screen layouts available with Merchant Desktop.

Reporting The Reporting screen provides access to the MicroStrategy Web 
Universal application and to the reports and graphs that have 
been supplied with Oracle Retail Price, Plan, Place, or Promote 
products or that you have created.

You cannot customize the Reporting screen except for its display 
name and description. 

Note: You cannot switch to a different layout after a screen is created. 
Therefore, make sure you know which layout you want before you 
create the screen. Otherwise, if you do want to switch to a different 
layout, you must create a new screen.

Table 4–6  Select Layout

Layout name Representation Type

Layout 1 Fixed layout

Layout 1 Inverted Fixed layout

Layout 2 Fixed layout

Note: Cell 1 is 16% high, Cell 2 
is 17% high, and Cells 3 and 4 
are 33% high.

Table 4–5 (Cont.) Screen Types

Screen type Description



Administrative Tasks

4-16 Oracle® Retail Plan Administration Guide

Layout 2 Inverted Fixed layout

Note: Cell 2 is 16% high, Cell 3 
is 17% high, and Cells 4 and 5 
are 33% high.

Layout 3 Fixed layout

Layout 3 Inverted Fixed layout

Layout 4 Fixed layout

Layout 4 Inverted Fixed layout

Layout 5 Fixed layout

Layout 5 Inverted Fixed layout

Layout 6 Fixed layout

Layout 7 Fixed layout

Layout 7 Inverted Fixed layout

Layout 8 Fixed layout

Table 4–6 (Cont.) Select Layout

Layout name Representation Type
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Copying a Screen
To create a new screen by copying the settings from an existing screen:

1. On the Screen Administration screen, click the Copy link for the screen you want.

The Copy Screen screen appears.

2. On the Copy Screen screen, type a new screen ID in the ID field.

3. In the Screen IDs Already In Use By You field, select the screen you want.

4. Click Save.

Editing a Screen
Use the Edit Screen screen to modify the settings for the existing screens. The only 
aspect of a screen that you cannot change is the layout. 

To edit a screen:

1. On the Screen Administration screen, under the ID column, click the screen you 
want.

The Edit Screen screen appears.

2. On the Edit Screen screen, edit the information you want. You can also add, 
remove, or edit the components that are assigned to the screen.

3. Click Save.

Layout 8 Inverted Fixed layout

Layout 9 Fixed layout

One Column Open layout

You can add as many rows as 
necessary, limited only by the 
memory available on your 
computer.

Two Column Open layout

You can add as many rows as 
necessary, limited only by the 
memory available on your 
computer.

Three Column Open layout

You can add as many rows as 
necessary, limited only by the 
memory available on your 
computer.

Table 4–6 (Cont.) Select Layout

Layout name Representation Type
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Deleting a Screen
To delete a screen:

1. On the Screen Administration screen, click the Delete link for the screen you 
want.

The Delete Screen screen appears.

2. On the Delete Screen screen, review the users accounts that will be affected once 
you delete the screen, and then click Delete.

Adding Components to a Screen
Screens are the containers for the components. Each screen consists of a layout and a 
type that determine how many components and what type of components you can 
add to the screen.

To add the components to a screen:

1. On the Screen Administration screen, under the ID column, click the screen you 
want.

The Edit Screen screen appears.

2. From the list of available components, click and drag a component to the screen 
layout. 

The component ID is highlighted in green (meaning “go”) when you select it, and 
the target cell outline turns red (meaning “stop” or “drop”) when you can release 
the mouse to place the component. When you drag the component on the screen, 
you can do the following actions:

■ You can move the components to any cell in the layout.

■ You can add the same component more than one time except for the Alert 
component. You can add only one Alert component per screen.

■ You can remove a component from the layout by clicking the X in the 
upper-right corner.

■ You can leave a cell blank.

■ You can reposition the components by clicking and dragging the component to 
another cell. If the cell is occupied, that component automatically moves to the 
next available space, or it switches places with the moved component.

3. When the Edit Screen screen appears with the selections you want, click the Save 
button.

Caution: There is no undo function. If you delete a screen and later 
want to use it, you must recreate it. In addition, deleting a screen 
removes it from the entire Merchant Desktop system. This means that 
the screen is deleted from all administrators as well as users.

Note: You can add unlimited components only to the one-column, 
two-column, and three-column layouts. For the other layouts, the 
maximum number of components is six, and you can leave a layout 
cell blank.
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Component Administration
The Component Administration screen lists sample components supplied with 
Merchant Desktop (denoted by the “pl - ” prefix) and those created by you and other 
administrators. Components created by other administrators appear only when those 
administrators have selected the Allow All Administrators To Access check box for 
one or more components.

All of the components on this list can be assigned to one or more screens.

Use the Component Administration screen as a starting place to do the following:

■ Create a component

■ Copy a component

■ Delete a component

■ Edit a component

■ Show or hide components to/from users’ and other administrators’ lists of 
component 

Component Administration Screen Fields
The following table describes the fields on the Component Administration screen:

Table 4–7  Component Administration Screen Fields

Field Description

Create Component Link Click this link to create a new component. The Create 
Component screen appears.

Allow Users To Add Click this check box to make the component available to all 
users.

Allow All Administrators 
To Access

Click this check box to share the component with other 
administrators.

This means that the component is available for copying, editing, 
or deleting by other administrators, and that when one 
administrator makes a change, all administrators receive that 
change. If multiple administrators are editing the same 
component at the same time, only the last-saved version is 
preserved.

ID Indicates the identification number (ID) assigned to the 
component. Each component name in the ID column is a link to 
the Edit Component where you can modify all of the component 
settings.

Components with the “pl - ” prefix are samples supplied with 
Merchant Desktop. To preserve these components for other 
administrators, copy them before modifying them.

Display Name The text that appears on the title bar of the component.

Description This column displays the description text entered for the 
component (on the Create Component or Edit Component 
screens). To change the description, click the component name 
and enter a new description on the Edit Component screen.

Copy Click this link to copy settings from an existing component to a 
new component ID. The Copy Component screen appears.
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Creating a Component
A component is a window that can be placed on Merchant Desktop screens. 
Depending on the type of component you create, you can add a variety of information 
from sources such as HTML pages, web sites, news feeds, Oracle Retail products, and 
reports.

To create a component:

1. On the Component Administration screen, click the Create Component link.

The Create Component screen appears.

2. On the Create Component screen, enter relevant information on the fields. For 
more information, see Create Component Screen Fields.

3. Click Save.

The Component Administration screen appears, and the new component appears 
in alphabetical order in the ID column.

Create Component Screen Fields
The following table describes the fields on the Create Component screen:

Delete Click this link to remove this component from the Merchant 
Desktop system. 

There is no undo function. If you delete a component and later 
want to use it, you must recreate it. Deleting a component has 
the following effects:

■ Removes the component ID from the Component 
Administration screen for you and all administrators.

■ Removes the Component from all user accounts to which it 
is currently assigned. The next time affected users log on to 
Merchant Desktop, the unassigned view message will 
appear.

Table 4–8  Create Component Screen Fields

Field Description

ID Indicates the identification number (ID) assigned to the 
component. Each component name in the ID column is a link to 
the Edit Component where you can modify all of the component 
settings.

Display Name The text that appears on the title bar of the component.

Description This column displays the description text entered for the 
component (on the Create Component or Edit Component 
screens). To change the description, click the component name 
and enter a new description on the Edit Component screen.

Table 4–7 (Cont.) Component Administration Screen Fields

Field Description
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Copying a Component
To create a new component by copying the settings from an existing component:

1. On the Component Administration screen, click the Copy link for the screen you 
want.

The Copy Component screen appears.

2. On the Copy Component screen, type a new component ID in the ID field.

3. In the Component IDs Already In Use By You field, select the screen you want.

4. Click Save.

Editing a Component
Use the Edit Component screen to modify the settings for the existing components.

To edit a component:

1. On the Component Administration screen, under the ID column, click the screen 
you want. A screen appears that includes the edit options for the component.

2. Edit the information you want. For more information on the edit options for each 
component, see Component Types

3. Click Save.

Padding Width The amount of padding (spacing) around each component. In 
combination with the other components, the amount of spacing 
between components.

Select one of the following options:

■ Thin – Approximately 5 pixels around each component 
window, resulting in approximately 10 pixels between 
components.

■ Medium – Approximately 10 pixels around each component 
window, resulting in approximately 20 pixels between 
components.

■ Thick – Approximately 20 pixels around each component 
window, resulting in approximately 40 pixels between 
components.

Height This option applies only to component windows in the 1-, 2-, 
and 3-column layouts. If the component window is in a fixed 
layout (such a Layout 1, Layout 1 Inverted, and so on), the 
height of the component window is set in the screen layout and 
you cannot change it.

You can set the height in pixels or percentage.

Title Bar Use the options in this field to show or hide the title bar for the 
component. 

Select the Hide option to show only the border of the component 
window without the title bar or Edit, help, minimize, or 
maximize buttons.

Select Component Type Select one of the component types you want. For more 
information, see Component Types.

Allow Personalization Click this check box to make the relevant field available for 
personalization.

Table 4–8 (Cont.) Create Component Screen Fields

Field Description



Administrative Tasks

4-22 Oracle® Retail Plan Administration Guide

Deleting a Component
To delete a component:

1. On the Component Administration screen, click the Delete link for the 
component you want.

The Delete Component screen appears.

2. On the Delete Component screen, review the users accounts that will be affected 
once you delete the component, and then click Delete.

Component Types
The following components are available in Merchant Desktop:

■ HTML – Displays the HTML page or any web site within the component window

■ HTTP Links – Displays the links to any web site or HTML page. The web site or 
HTML appears in a separate browser window

■ Newsfeed – Displays the RSS (Rich Site Summary or Really Simple Syndication) 
feeds

■ Product Links – Provides the links to Oracle Retail products such as Price, Plan, 
Place, and Promote

■ Filtered Graph – Displays a single graph that will update dynamically based on 
merchandise, location, and period hierarchy selections from the Filter component

■ Graph – Displays a single graph or chart. Several graphs are supplied with 
Merchant Desktop. For a list of the available graphs, see Graph Components

■ Filtered Report – Displays a single report that will update dynamically based on 
merchandise, location, and period hierarchy selections from the Filter component

■ Report – Displays a single report. You can select any of the reports supplied with 
Merchant desktop, or any reports that you create

HTML Component
Use the HTML component to include an HTML page or any web site within the 
component window.

The following table describes the edit options for the HTML component:

Caution: There is no undo function. If you delete a component and 
later want to use it, you must recreate it. In addition, deleting a 
component removes it from the entire Merchant Desktop system. This 
means that the component is deleted from all administrators as well as 
users.

Table 4–9  Edit Options for the HTML Component

Option Description

Source Enter the path and file name of an HTML page or web site that 
you want to display in this component. If you want to display 
the HTML page or web site in a separate browser window, use 
the HTTP links component.
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HTTP Links Component
Use the HTTP Links component to include links to any Web site or HTML page. The 
Web site or HTML page appears in a separate Web browser window.

The following table describes the edit options for the HTTP Links component:

Newsfeed Component
Use the Newsfeed component to include the RSS feeds.

The following table describes the edit options for the Newsfeed component:

Table 4–10  Edit Options for the HTTP Links Component

Option Description

Show Description Use this option to show or hide the description text that appears 
beneath all of the HTTP links.

Tool Tip Use this option to show or hide a tool tip for the link. 

The tool tip is the text that appears in a yellow box when you 
hover (hold the mouse pointer over) the link. The default hover 
text is the URL you enter for link.

Show Image Use this option to show or hide the image associated to the link. 
This is an optional image that appears to the left of the link 
name. When you set up a link, you can also specify the location 
to the image.

Allow Add/Remove Links Use this option to determine whether the users can remove or 
add additional links to the links you supply. Users can still 
change the links unless you also select the Allow Personalization 
check boxes for each link.

Link Edit Area

Click the Add Link button to add multiple links. To remove a link, click the Cancel icon in the 
top-right corner of each link.

Link Location (URL) of the Web site or the HTML page.

Link Name Name of the link.

Link Description Description text for the link.

Link Image Location of the associate image.

Table 4–11  Edit Options for the Newsfeed  Component

Option Description

Source Type the URL of the Web site that provides the RSS news feed 
you want. You must create a new component for each RSS news 
feed. Some popular news feeds are listed below:

■ eMediaWire™ (http://www.emediawire.com/) is a 
newswire service of PRWeb™.

■ PRWeb™ (http://www.prweb.com) is a free online press 
release distribution service. You can distribute press releases 
here, or you can subscribe to press releases from a variety of 
categories from in several different languages.

■ Yahoo!® Business (http://news.yahoo.com) offers a variety 
of RSS feeds in all areas of business.
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Product Links Component
Use the Product Links component to provide links to the other Oracle® Retail products 
such as Price Optimization, Plan, Place, and so on.

The following table describes the edit options for the Product Links component:

Display Use this option to set up the way the news feeds appears in the 
component. Select one of the following options:

■ Static – Shows all of the headlines (and first sentences, if 
selected) at one time. If the component window is not large 
enough, a vertical scroll bar appears.

■ Fading – Shows one headline (and first sentences, if 
selected) at a time, fading from white (invisible) to gray to 
full black and then starting again with the next headline, 
cycling through the number of headlines you selected for 
links shown.

■ Horizontal Scrolling – Shows headlines (and first sentences, 
if selected) starting from the right and moving from right to 
left within the width of the component window.

■ Vertical Scrolling – Shows headlines (and first sentences, if 
selected) starting from the bottom and moving to the top, 
scrolling within the height of the component window.

Headline Summary Use this option to show or hide the first sentence of the story. 
The sentence appears directly below the headline for static, 
fading, and vertical displays, and it appears directly to the right 
of the headline for horizontal displays.

Speed Use this option to set up the time interval (in seconds) for the 
fade and scroll cycles within the component. 

Links Shown Enter the number of headlines you want to appear in the 
component. Each headline is a link to the actual story on the site 
that is hosting the RSS news feed.

Table 4–12  Edit Options for the Product Links Component

Option Description

Show Description Use this option to show or hide the description text set up for 
the product link.

Tool Tip Use this option to show or hide a tool tip for the link. 

The tool tip is the text that appears in a yellow box when you 
hover (hold the mouse pointer over) the link. The default hover 
text is the URL you enter for link.

Show Image Use this option to show or hide the product logo. This is an 
optional image that appears to the left of the link name. When 
you set up a product link, you can also specify the location to the 
image.

Link Edit Area

Link Location (URL) of the product.

Link Name Name of the product.

Link Description Description text for the product.

Link Image Location of the product logo or an associated image.

Table 4–11 (Cont.) Edit Options for the Newsfeed  Component

Option Description
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Filtered Graph Component
Use the Filtered Graph component to include a single graph that will update 
dynamically based on merchandise, location, and period hierarchy selections from the 
Filter component.

The following table describes the edit options for the Filtered Graph component:

Graph Component
Use the Graph component to include a single graph or chart. This section includes 
information on the graphs formats that are supplied with Merchant Desktop.

The following table describes the edit options for the Graph component:

Filtered Report Component
Use the Filtered Report component to include a single report that will update 
dynamically based on merchandise, location, and period hierarchy selections from the 
Filter component.

The following table describes the edit options for the Filtered Report component:

Report Component
Use the Report component to include a single report. You can select any of the reports 
supplied with Merchant desktop, or any reports that you create.

The following table describes the edit options for the HTML component:

Show Use the Show or Hide option to determine whether the product 
link information appears in the component window.

Table 4–13  Edit Options for the Filtered Graph Component

Option Description

Fit To Window Use this option to fit (expand or shrink) the graph in the space 
available. Click No to display the graph in the original size.

Selected Graph Use the expand (+) and collapse (-) icons in the tree structure to 
select the graph (of a report) for this component.

Table 4–14  Edit Options for the Graph Component

Option Description

Fit To Window Use this option to fit (expand or shrink) the graph in the space 
available. Click No to display the graph in the original size.

Selected Graph Use the expand (+) and collapse (-) icons in the tree structure to 
select the graph (of a report) for this component.

Table 4–15  Edit Options for the Filtered Report Component

Option Description

Expand to Full Width Use this option to fit (expand or shrink) the report in the space 
available. Click No to display the report in the original size.

Selected Report Use the expand (+) and collapse (-) icons in the tree structure to 
select the report for this component.

Table 4–12 (Cont.) Edit Options for the Product Links Component

Option Description
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Common Edit Options for All the Components
The following table describes the edit options that are common across all the 
components:

Table 4–16  Edit Options for the Report Component

Option Description

Expand to Full Width Use this option to fit (expand or shrink) the report in the space 
available. Click No to display the report in the original size.

Selected Report Use the expand (+) and collapse (-) icons in the tree structure to 
select the report for this component.

Table 4–17  Common Edit Options for All Components.

Field Description

ID Indicates the identification number (ID) assigned to the 
component. Each component name in the ID column is a link to 
the Edit Component where you can modify all of the component 
settings.

Display Name The text that appears on the title bar of the component.

Description This column displays the description text entered for the 
component (on the Create Component or Edit Component 
screens). To change the description, click the component name 
and enter a new description on the Edit Component screen.

Padding Width The amount of padding (spacing) around each component. In 
combination with the other components, the amount of spacing 
between components.

Select one of the following options:

■ Thin – Approximately 5 pixels around each component 
window, resulting in approximately 10 pixels between 
components.

■ Medium – Approximately 10 pixels around each component 
window, resulting in approximately 20 pixels between 
components.

■ Thick – Approximately 20 pixels around each component 
window, resulting in approximately 40 pixels between 
components.

Height This option applies only to component windows in the 1-, 2-, 
and 3-column layouts. If the component window is in a fixed 
layout (such a Layout 1, Layout 1 Inverted, and so on), the 
height of the component window is set in the screen layout and 
you cannot change it.

You can set the height in pixels or percentage.

Title Bar Use the options in this field to show or hide the title bar for the 
component. 

Select the Hide option to show only the border of the component 
window without the title bar or Edit, help, minimize, or 
maximize buttons.

Allow Personalization Click this check box to make the relevant field available for 
personalization.
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Working with the Reports
The Reporting tab on the Merchant Desktop User Interface enables you to view, 
export, or print the reports that have been set up based on your business needs. It also 
enables you to save or subscribe to reports.

Merchant Desktop includes the following features that help you effectively view, 
export, and manage the reports:

■ Shared Reports – includes a list of pre-defined reports.

■ Create Report – helps you create and publish the required reports.

■ History List – includes an up-to-date summary of the status of the requests.

■ My Reports – includes the reports that you have created or saved for future use.

■ My Subscriptions – includes a list of reports to which you have subscribed.

■ Preferences – helps you set up preferences such as, Grid display, Graph display, 
Print, Export, and PDF.

Figure 4–7 Reporting Tab of the Merchant Desktop User Interface

Generating the Reports
The Shared Reports folder contains a list of pre-defined reports that you can use to 
export or print assortment based information.

To generate the shared reports:

1. On the Reporting tab, click the Shared Reports link.

2. On the Shared Reports page, click the report you want.

A form appears that helps you select the parameters before generating the report.

3. Select the parameters you want to include in the report, and then click Execute 
Report.
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For each report in the Shared Reports folder, the following links provide quick access 
to view or set up parameters before you generate the report:

■ Subscriptions – Click this link to view the subscription for this report.

■ Export – Click this link to view and set up the export options in the Preferences 
page.

■ PDF – Click this link to view and set up the PDF print options.

Creating Your Own Reports
The Create Report feature enables you to create your own reports that include the 
metrics you want. You can create a report using one of the following options:

■ Report Builder – enables you to create a report based on the merchandise 
attributes and metrics you want.

■ Report Wizard – enables you to create a report based on the existing report 
templates and filters.

Using the Report Builder
To create a report using the Report Builder:

1. On the Create Reports page, click Report Builder. 
A form appears that helps you select the attributes and metrics for the report.

2. Select the parameters you want, and then click Execute Report.

Using the Report Wizard
To create the report using the Report Wizard:

1. On the Create Reports page, click Report Wizard. 
A form appears that helps you select the templates and filters that you want to use 
in the report.

2. Once you select the templates and filters, click Execute Report.

Setting Up Preferences
The user interfaces for the Merchant Desktop and reports display information based 
on the display, print, and export parameters that have been set up for your user 
account. The Preferences feature enables you to update these parameters.

To set up preferences:

1. On the Reporting tab, click Preferences.

The Preferences page appears, with links to the groups on the left side of the page.

2. For each group, update the preferences you want, and then click Apply. For more 
information, see Preference Categories.

To revert back to the default values, click Load Default Values.

Preference Categories
The Preferences feature includes the parameters in the following categories:

■ General (See Parameters in the General Category)

■ Grid Display (See Parameters in the Grid Display Category)
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■ Graph Display (See Parameters in the Graph Display Category)

■ Print (See Parameters in the Print Category)

■ Export (See Parameters in the Export Category)

Parameters in the General Category
The following table describes the parameters in the General category:

Parameters in the Grid Display Category
The following table describes the parameters in the Grid Display category:

Table 4–18  Parameters in the General Category

Parameter Description

Default start page Use this parameter to select a default start page. 

Locale Use the parameters in this section to set up the locale settings 
such as language, time zone, and number and date format.

Dynamic HTML Use this parameter to specify the use of Dynamic HTML in the 
reports.

Accessibility mode Use this parameter to generate reports that are compatible with 
the screen readers.

Select the Enable screen reader compatibility check box to enable 
accessibility.

Drop down menus Use this parameter to view the menu options (open the menu), 
when you click the menu.

Clear the Require mouse click to open menus check box to view the 
menu options when you hover the mouse pointer over the 
menu.

Font style Use this parameter to select the font and font size for the reports.

Table 4–19  Parameters in the Grid Display Category

Parameter Description

Grid Style Use this parameter to specify the use of the grid format in the 
report definition or the default grid style you set up using the 
other parameters on this page.

Default Grid Style Use this parameter to specify the grid style for the report.

Maximum rows in grid Use this parameter to limit the number of rows that appear in 
the grid. 

In case the report contains more rows, the additional rows 
appear in the next page.

Maximum columns in grid Use this parameter to limit the number of columns that appear 
in the grid.

In case the report contains more columns, you can view the 
additional columns using the right arrow icon at the right hand 
corner of the report.

Show attribute form names Use this parameter to view the form names of the attributes in 
the report.

Automatic page-by Use this parameter to specify that the page automatically loads 
with the new information, when you select an option in the 
Page-by drop-down list.
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Parameters in the Graph Display Category
The following table describes the parameters in the Graph Display category:

Parameters in the Print Category
The following table describes the parameters in the Print category:

Use images for depicting 
expand and contract in 
outline mode

Use this parameter to specify the use of images for the expand 
and collapse icons in the outline mode.

Table 4–20  Parameters in the Graph Display Category

Parameter Description

Graph size Use the parameters in this section to set the size of the graph.

Show graph reports by 
default in ’Grid and Graph’ 
view mode

Select this check box to include the graph, when you choose to 
view the report in the ’Grid and Graph’ mode.

Table 4–21  Parameters in the Print Category

Parameter Description

Orientation Use this parameter to select the page orientation for the reports. 
You can select the Portrait option, or the Landscape option.

Paper size Use this parameter to specify the page size.

Header and Footer Click the Edit Custom Settings link to set up the header and 
footer for the reports. The Header / Footer Editor appears, 
which helps you set up the header and footer for the report.

Scaling Use this parameter to set up the page scaling options.

Margins (inches) Use this parameter to set up the page margins for the report.

Maximum header size 
(inches)

Use this parameter to limit the size of the header in the report. 

In case the report needs more space for the content, the headers 
and footers are removed from the report. 

Maximum footer size 
(inches)

Use this parameter to limit the size of the footer in the report. 

In case the report needs more space for the content, the headers 
and footers are removed from the report. 

Disable DHTML printing Select this check box to print the report without DHTML 
formatting.

Show popup print dialog Select this check box to display the Print dialog box when you 
view the Printable Version of the report.

Print cover page with filter 
details

Select this check box to include a cover page with details of the 
filters used in the report.

Open new window when 
printing

Select this check box to open a new page to preview the report.

Print the grid and the graph 
on the same page

Select this check box to print the graph and grid on the same 
page.

Expand all page-by fields 
when printing

Select this check box to include all combinations of the objects 
(in the Page-by axis) in the report.

Table 4–19 (Cont.) Parameters in the Grid Display Category

Parameter Description
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Parameters in the Export Category
The following table describes the parameters in the Export category:

Viewing the Reports
Once you generate the report, you can perform various tasks on the information 
included in the report. On the report screen, the following menus help you edit the 
views, the filters, and the information in the report:

■ Report – includes options to subscribe, save, print, or export the report.

■ View – includes options to view the graph, filters, and toolbars.

■ Data – includes options to sort, drill, re-prompt, or filter the information in the 
report.

■ Format – includes options to edit the report interface.

Show options when printing Select this check box to view and set up the print options each 
time you print the report.

Table 4–22  Parameters in the Export Category

Parameter Description

Export Use this parameter to set the area for the export.

Export grids to Use this parameter to specify the output format.

Export graphs to Use this parameter to specify the format in which you want to 
export the graph. You can export the graph to the HTML or 
Microsoft® Excel® formats.

Export documents to Use this parameter to specify the format in which you want to 
export the document.

Open new window when 
exporting

Select this check box to open a new page with the report that 
you extract.

Export metric values as text 
(Excel only)

Select this check box to extract the numeric values as text.

Export headers as text 
(Excel only)

Select this check box to extract the header values as text.

Export filter details Select this check box to extract the details of the filter.

Show options when 
exporting

Select this check box to view and set up the export options, each 
time you export the report.

Table 4–21 (Cont.) Parameters in the Print Category

Parameter Description
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Figure 4–8 Report User Interface

The following icons, on the top-right corner of the screen, provide easy access to 
certain commonly used features:

Report Menu
The Report menu includes options that help you subscribe, save, print, or export the 
report. The following table describes the options in the Report menu:

Icon Icon name

Graph icon

Click this icon to view the graph.

Grid and Graph icon

Click this icon to view the grid and graph on the same page.

Grid icon

Click this icon to view the grid.

Print icon

Click this icon to print the report.

Export icon

Click this icon to extract the report in a format you want.

Re-prompt icon

Click this icon to generate the report with a different selection criteria.

Refresh icon

Click this icon to update the report screen.

Save icon

Click this icon to save the report.

Table 4–23  Options in the Report Menu

Option Description

New Click this option to create a new report. The Create Report 
screen appears. For more information, see Creating Your Own 
Reports.
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View Menu
The View menu includes options that help you view graphs, filters used, toolbars, and 
certain user interface components. The following table describes the options in the 
View menu:

Save As Click this option to save the report. The SAVE REPORT screen 
appears, which enables you to save the report in the My Reports 
or Shared Reports folder. 

On the Save Report screen, you can also create subfolders within 
a folder.

Add to History List Click this option to add the report to the history list. The History 
List enables you to store and view an up-to-date summary of the 
generated reports.

Subscribe Click this option to schedule the report on a regular basis. The 
SUBSCRIPTIONS panel appears on the report screen.

Print Click this option to set up and view a printable version of the 
report. The Print Options screen appears, which helps you set up 
the header, footer, scaling, and other page setup options for the 
report.

To print the report:

■ Once you set up the print options, click Show Printable 
Version. The report displays in an HTML format. You can 
now print the report in the format you want.

Export Click this option to export the report in a format you want. The 
Export Options screen appears, which helps you choose the 
format and other details for the report.

Report Details Click this option to view the information on the filters, 
templates, and parameters used for the report. It also provides 
information on the SQL statements used to display the 
information in the report.

Table 4–24  Options in the View Menu

Option Description

Grid Click this option to view the grid.

Graph Click this option to view the graph. You can also click the Graph 
icon on the top-right corner of the screen.

Grid and Graph Click this option to view both the graph and the grid on the 
same page.

Report Filter Click this option to view the filters used to generate the report. 
The REPORT FILTER panel that appears on the report screen 
lists the filters used for the report.

Table 4–23 (Cont.) Options in the Report Menu

Option Description
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Data Menu
The Data menu includes options that help you sort, drill, filter, or refresh the 
information in the report. It also enables you to insert new metrics or run the report 
with different selection criteria. The following table describes the options in the Data 
menu:

View Filter Click this option to view and add additional filters to the report. 
The VIEW FILTER panel appears on the report screen. 

To add an additional filter:

1. Click Add Condition to add additional filter conditions to 
filter the information included in the report. 

2. Once you set the attribute, click Continue, and then specify 
a condition (Qualify option) or value (Select option) for the 
attribute.

3. Click the tick mark icon (to the right) to apply the filter.

Object Browser Click this option to view the objects used in the report.

Toolbars Click this option to select the toolbars that you want on the 
report screen.

Pivot Buttons Click this option to view the pivot buttons for the columns in the 
report. The pivot buttons help you rearrange the information in 
the format you want, based on each column. 

It includes the following buttons:

■ Move to left – Click to move the column to the left.

■ Move to right – Click to move the column to the right.

■ Move to columns – Click to rearrange the information in the 
column, and display as a group of columns.

■ Move to rows – Click to rearrange the information in the 
column, and display it in rows.

■ Page by this field – Click to rearrange the information, and 
display a single page that includes the information that is 
associated with each value in the column.

■ Remove from Grid – Click to remove the column from the 
grid.

Sort Buttons Click this option to view the sort buttons. The sort buttons 
appear to the right of each column header.

Page_by_section Click this option to view the PAGE BY panel on the report 
screen. The PAGE BY panel helps you select a different grid 
format for the report.

Table 4–25  Options in the Data Menu

Option Description

Add View Filter Condition This menu option is similar to the View Filter option in the View 
menu. Click this option to add an additional filter to the report.

Table 4–24 (Cont.) Options in the View Menu

Option Description



Working with the Reports

Managing Reports 4-35

Sort Click this option to sort the information in the report. The SORT 
panel appears on the report screen. 

To sort the information:

1. On the SORT panel, select the sort condition you want.

2. Click Apply to review the results.

Or

Click OK to accept the result and close the SORT panel.

Drill Click this option to view the information at different levels in the 
report. The DRILL panel appears on the report screen. It helps 
you drill from an attribute, to the immediate sublevels. 

You can also drill the report in the one of the following ways:

■ Hyperlink drilling – Certain objects in the report have a 
default drilling option, and the object appears to have a 
hyperlink. Click the hyperlink to drill to the information at 
the next level.

■ Right-click drilling – Right-click on an object, and use the 
Drill menu to drill to the level you want.

Filter on Selections Click this option to view the information you want, by selecting 
the objects in the report and applying filters. The FILTER ON 
SELECTIONS panel appears. Select the objects you want to view, 
and then click Apply or OK.

Reset Data Click this option to reset the drills or additional filters applied 
on the report.

Refresh Click this option to update the report screen.

Re-prompt Click this option to generate the report with a different selection 
criteria. A form appears that shows the current selections for the 
report, and helps you select a different criteria for the report. 

Once you select the criteria you want, click Execute Report to 
generate the report.

Insert New Metric Click this option to insert a new metric in the report. The 
RENAME/EDIT OBJECTS panel appears. You can insert an 
existing metric, or create a new metric (based on the metrics 
available for the report).

To create and insert a new metric:

1. On the RENAME/EDIT OBJECTS panel, select New metric 
from the drop-down list.

2. In the Name field, type a name for the metric.

3. In the Definition field, set up a metrics definition, based on 
the metrics available (or displayed) in the report.

For example,

[Pack Size} * [Num Packs]

Rename/Edit Objects Click this option to rename or edit the metrics you inserted in 
the report. The RENAME/EDIT OBJECTS panel appears.

You can rename or edit the metrics that you created, through 
your user account.

Table 4–25 (Cont.) Options in the Data Menu

Option Description
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Format Menu
The Format menu includes options that help you edit the report screen and review the 
reports better. The following table describes the options in the Format menu:

Personalizing Merchant Desktop
This section describes how you, as a user with MD_POWER_USER role (power user), 
can effectively personalize the Merchant Desktop based on your need. Use the 
information provided in this section along with the administrative tasks, mentioned in 
this chapter (see Administrative Tasks), to better understand the user interface 
components of Merchant Desktop and the associated features.

When you first access your Merchant Desktop, the system administrator creates and 
assigns a view and some screens for you. You may personalize those screens and 
create new ones depending on the access rights assigned to your user account. 

To get started with Merchant Desktop, try these topics: 

■ About Personalization

■ Personalizing Your View

■ Personalizing Screens

■ Personalizing Components

Totals Use the Totals sub menu to view the subtotals or grand totals for 
the following calculations:

■ Average

■ Count

■ Maximum

■ Minimum

■ Standard Deviation

■ Total

■ Variance

Table 4–26  Options in the Format Menu

Option Description

Lock Grid Headers This menu option enables you to review big reports better by 
freezing (Lock) certain rows or column headers. When you scroll 
through the report, it is then easier to associate each object with 
values.

Merge Column Headers Click this option to group the column headers or values that are 
repeated.

Merge Row Headers Click this option to group the row headers or values that are 
repeated.

Outline Click this option to view the information represented in the 
expandable and collapsable sections. For most of the reports, 
small plus sign icons appear to the left of header in the left-most 
column. Click this icon to expand and view the sections within 
the header.

Show Banding Click this option to view the alternate color bands in the reports.

Table 4–25 (Cont.) Options in the Data Menu

Option Description
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■ About Views

■ About Screens

■ About Components

About Personalization
When you first log on to the Merchant Desktop, a view with one or more screens and 
components appears. This view is created for you by the administrator. Depending on 
the privileges assigned to your user account, you may be able to personalize the 
following: 

■ Component position and type

■ Screen tab names and order, along with adding new screens

■ The color scheme or "skin" of the view, which affects each screen and component

■ Different aspects of each component, depending on the component type, such as 
the title bar of each component or the padding around it.

Personalization Privileges
Pencil buttons denote personalization. When you click a pencil button, the 
corresponding personalization screen appears.

■ If no Pencil buttons appear, you have a standard user account, and the 
administrator has denied all personalizing. In this case, you will find that the view, 
screens, and/or components are updated with a new look or new information 
each time the administrator makes updates.

■ If the Pencil button appears, possibly in some places but not others, you have a 
power user account, and the administrator has allowed you to personalize only 
some elements.

It is possible, however, for the administrator to remove the view of one or more 
screens.

■ If some parameters are missing when you compare a personalization screen to the 
help, the administrator has prohibited the missing parameters from being 
changed. You may change any of the available parameters.

Personalizing Your View
You must have a power user account to make any changes to your view. If no Pencil 
buttons are available when you log on to Merchant Desktop, you most likely have a 
standard user account.

Your view consists of the row of tabs shown below:

Figure 4–9 User View

As long as the administrator has given you privileges to do so, you can personalize 
your view as follows:

■ Add one or more screens
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■ Remove one or more screens

■ Reorder the screens

■ Change the skin (color scheme)

To personalize your view:

1. At the right end of the row of screen tabs, click the Pencil button.

If the Pencil button is not available, the administrator has prohibited changes to 
the view. Otherwise, the View Personalization screen appears.

2. Complete the View Personalization screen as follows:

Notes: 

■ If one of the parameters listed below is missing from the screen, the 
administrator has prohibited that parameter from being changed. 

■ If the parameter appears but is grayed out and you can't edit it, clear the Use 
Default check box. That will allow you to change the parameter, but it will not 
allow you to receive updates from the administrator for that parameter.

Table 4–27  Personalizing Your View

To Do this

Add a screen In the Available Screens list, click the screen name 
and then click the Add button. The screen name 
moves to the Screens In View list.

Remove a screen In the Screens In View list, click the screen name 
and then click the Remove button. The screen name 
is removed from the list.

Reorder the screens In the Screens In View list, click a screen name and 
then click the Top, Up, Down, or Bottom buttons to 
move the screen name to its target position.

Change the skin Change skins when you want to adjust the 
dominant color scheme of your view, screens, and 
components.

You can select skins from those provided by the 
administrator.

From the Skin list box, select the name of a skin. 
Each skin name includes the predominant color.

The color scheme of the skin you selected is applied 
to all of the screen tabs and all of the component 
title bars.

Set the home screen From the Home Screen list box, select the name o 
the screen that you want to have the focus when 
you first log on. Setting the default home screen is 
different from setting screen order.

■ Screen order determines the order of the tabs 
from left to right. 

■  Home screen determines which of those tabs is 
in the foreground when you log on.

For example, you could set the first (left most) 
screen to be the home screen, or you could set the 
third screen to be the home screen.
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3. When the View Personalization screen reflects the changes you want, click the 
Save button.

The updates are effective immediately.

Personalizing Screens
You must have a power user account to make any changes. If no Pencil buttons are 
available when you log on to Merchant Desktop, you most likely have a standard user 
account.

You may personalize screens to the extent permitted by the administrator. Following is 
a list of the changes you may make:

■ Screen name - The text that appears on each screen tab and the corresponding 
personalization screen. Rename a screen when you want different text to appear 
on the screen tab. 

■ Screen layout - The order and position of the components

■ Components - The number and type of components that appear on the screen

To personalize a screen:

1. Click the tab of the screen you want to personalize.

The screen appears, and a Pencil button appears next to the name of the screen, as 
in this example: 

Figure 4–10 Personalizing Your Screen

2. Click the Pencil button.

The Personalization screen appears. 

3. Complete the Screen Personalization Screen as follows:

Notes: 

■ If one of the parameters listed below is missing from the screen, the 
administrator has prohibited that parameter from being changed. 

■ If the parameter appears but is grayed out and you can't edit it, clear the Use 
Default check box. That will allow you to change the parameter, but it will not 
allow you to receive updates from the administrator for that parameter.

Table 4–28  Personalization Screen Fields

To Do this

Change the screen name Enter new text in the Display Name text box. 

The text on the screen tab as well as the title bar of the 
personalization screen update with this text.
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4. Click the Save button.

The changes you made are effective immediately.

Personalizing Components
You must have a power user account to make any changes. If no Pencil buttons are 
available when you log on to Merchant Desktop, you most likely have a standard user 
account.

You may personalize components to the extent permitted by the Desktop 
administrator. In addition, the features you may personalize depend on the 
component type. In general, you may change the following:

■ Rename the title that appears in the title bar, or simply hide it

■ Adjust the spacing between components

Change the position of 
components

You can change the order and position of components within the 
confines of the assigned screen layout type. For example, if the 
screen is assigned a two-column layout, you cannot change that to a 
three-column layout.

If you need a different layout, such as more columns or a different 
arrangements of rows and columns, request that from the 
administrator.

Finally, if the layout is a 1-, 2-, or 3-column open layout, you can 
add as many components as necessary, limited only by the memory 
available to your browser.

In the layout, click the name of the component you want to move 
and drag it to the target location. 

■ When you click the name of a component, it is highlighted in 
green indicating that you can "go" or "drag" the component to a 
cell in the layout

■ As you drag the component across the layout, a red outline 
indicates where you can "stop" or "drop" that component.

A displaced component moves to the open spot left by the moved 
component

Change the number of 
components

Note: You can add unlimited components only to the one-column, 
two-column, and three-column layouts. For the other layouts, the 
maximum number of components is from one to six. You can leave 
a layout cell blank.

■ To remove a component, click the X in the upper-right corner 
of that component's cell

■ To add a component, click it in the list box on the left and drag 
it to its target location

You can add multiple copies of a component to one screen.

Change the type of 
components

Note: Some screens have components added to them by default.

Select the new component type from the list box and drag it to its 
target location.

Edit the component Click the Pencil button and complete the resulting component 
screen.

To save the change to the component, you must click Save both on 
the component screen and on the Screen personalization screen.

Table 4–28 (Cont.) Personalization Screen Fields

To Do this
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■ Change the content of a component

■ Change the look or behavior of the content

To personalize a component:

1. On the component you want to personalize, click the Pencil button.

A screen that corresponds to the component type appears. This screen is titled the 
same as the component.

2. Complete the screen. The parameters differ depending on the component type:

■ HTML Component screen

■ HTTP Links Component screen

■ News Feed Component screen

■ Graph Component screen

■ Report Component screen

3. When the screen reflects your choices, click Save. The changes take effect 
immediately.

About Views
A view is the collection of screens and their components that appear on each user's 
Merchant Desktop. The administrator creates the views, screens, and components in 
any order, but it is helpful if you understand how they relate to each other: 

■ Components are the building blocks of screens, and they contain the actual 
content. They appear as individual windows on each screen.

■ Screens are the building blocks of views, and they serve as containers for 
components.

■ Views are the "packages" that hold the screens (basically, a row of screen tabs). 
Views are what an administrator assigns to Merchant Desktop users.

About Screens
Screens are the containers for components (each within its own window). Essentially, 
screens provide layout while component windows provide content. On the Merchant 
Desktop, screens are identified by the row of tabs that appear near the top of the 
screen. Each screen consists of the following:

■ A type (Standard or Reporting)

■ A layout (such as one column, two column, etc.)

■ One or more components

Screen Types

Table 4–29  Screen Types

Screen type Description

Standard The Standard screen is the most flexible of all of the 
screen types, and it allows you to add all of the 
component types.
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About Components
Components are boxes of content that are placed in a screen. Components are similar 
to the windows you are familiar with in the Windows operating system—you may 
resize them, minimize them, maximize them, change their position, and close them.

Each component belongs to a parent (or owner) screen. Thus, you may access and 
view that component only from that parent screen. Because of this ownership, the 
administrator may or may not allow you to customize each component.

The same component may appear multiple times on one screen, and it may appear on 
multiple screens.

On the Merchant Desktop, components are identified by borders and controls such as 
a pencil button and an X in the upper-right corner. Component windows consist of the 
following:

■ Properties that are common to all components, such as:

■ A type, which determines the content and properties you can set

■ A title bar description

■ A size and position in its parent (owner) screen

■ A skin (color scheme) inherited from its parent (owner) screen

■ Properties that are unique to each component, such as scrolling patterns for the 
news feed component or specific URLs for the HTTP links component

Component Types
Each component type determines the content you may add as well as the properties 
you may set. Merchant Desktop provides the following component types:

■ News Feed Component Type

■ HTTP Links Component Type

■ HTML Component Type

■ Report Component Type

■ Graph Component Type

News Feed Component Type
The news component is designed to display retail and other news headlines as RSS 
(Rich Site Summary or Really Simple Syndication) feeds.

Figure 4–11 News Feed Component Type

Reporting The Reporting screen provides access to reports and 
graphs that have been supplied with Merchant 
Desktop.

Table 4–29 (Cont.) Screen Types

Screen type Description
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To pause the scrolling or fading, simply place the mouse pointer on the text. When you 
move the pointer, the text begins scrolling or fading again.

When you click any of the listed story titles, a new browser window opens with the 
text of the story.

To change the appearance or contents of this News Feed component, click the Pencil 
button in the title bar and you will see the News Feed Component screen. If the pencil 
button is not present in the title bar, the administrator has prohibited this component 
from being changed.

HTTP Links Component Type
The HTTP Links component displays links to any web site. For example, you may 
want to display links to competitors' web sites, or you may want to display links to 
sites that you access often throughout the day.

Figure 4–12 HTTP Links Component Type

When you click a link, a new browser window opens. To return to Merchant Desktop, 
do any of the following:

■ Close the browser window that just opened.

■ Press Alt+Tab until the Internet Explorer Merchant Desktop icon is selected.

To change the appearance or contents of this HTTP Links component, click the Pencil 
button in the title bar and you will see the HTTP Components screen. If the Pencil 
button is not present in the title bar, the administrator has prohibited this component 
from being changed.

Table 4–30  Messages - News Feed Component

If this message appears Do this

Error parsing RSS NEWS FEED. 
Bad XML File.

Wait until the host site updates its XML file. 
The XML file contains the contents of the news 
feed.

Error in RSS News Feed. Wait until the host site updates its XML file. 
The XML file contains the contents of the news 
feed.

Too much data to download. Decrease the number of links displayed and/or 
hide the summaries/first sentences. (Click the 
pencil button and complete the resulting News 
Component Feed screen).

This message appears when the XML contains 
greater than 10,000 characters for display.
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HTML Component Type
The HTML component displays information that originates in HTML format. It is 
intended for displaying corporate calendars, promotional event dates, company 
intranet Web site, and so on.

Figure 4–13 HTML Component Type

To change the appearance or contents of this HTML component, click the Pencil button 
in the title bar and you will see the HTML Component screen. If the Pencil button is 
not present in the title bar, the administrator has prohibited this component from being 
changed.

Report Component Type
The Report component provides you with a single report specific to your company's 
data.

Figure 4–14 Report Component Type

While the Reporting screen (see "Screen Types") provides access to all graphs and 
reports, you may want to set up a component for a specific report for which you have 
created custom filters. For that case, Merchant Desktop provides you with this Report 
component (as well as a "Graph Component Type").

To change the appearance or contents of this Report component, click the Pencil button 
in the title bar and you will see the Reports Component screen. If the Pencil button is 
not present in the title bar, the administrator has prohibited this component from being 
changed.

Graph Component Type
The Graph component provides you with various graphical visual aids you may 
personalize to your company's data.
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Figure 4–15 Graph Component Type

While the Reporting screen (see "Screen Types") provides access to all graphs and 
reports, you may want to set up a component for a specific graph that you have 
customized. For that case, Merchant Desktop provides you with this Graph 
component (as well as a "Report Component Type").

Pie Charts
MicroStrategy comes with the ability to create Pie charts and display them through the 
Merchant Desktop.

Figure 4–16 Pie Charts

Bar and Line Charts
MicroStrategy comes with the ability to create line and Bar Charts that may be 
displayed through the Merchant Desktop.

Figure 4–17 Bar and Line Charts

To change the appearance or contents of this Graph component, click the pencil button 
in the title bar and you will see the Graph Component screen. If the pencil button is 
not present in the title bar, the administrator has prohibited this component from being 
changed.

Other
MicroStrategy comes with various types of Graphs you may access through the 
Merchant Desktop. To explore your options, go to the Reports Tab and click on the 
Preferences option and the Graph display hyperlink. Follow the Micro Strategy Help.

Troubleshooting
Following are problems and solutions for the Merchant Desktop feature.
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Table 4–31  Troubleshooting for Merchant Desktop

Problem Solution

I can't change anything, and there are no pencil 
buttons.

This occurs when your user account is assigned a read-only role 
that prohibits any changes. If you want to be able to customize 
some Merchant Desktop features, ask the administrator to 
update your user account.

The help lists some options that don't appear on 
my screens.

The help system shows all of the available Merchant Desktop 
options, but your user account may be prohibited from using 
those options. When this is the case, the option does not appear 
in the user interface. For example, if your user account prohibits 
adding web sites to the HTTP links component, the Add button 
does not appear on the HTTP links personalization screen.

There are some changes on my Merchant 
Desktop view, screen, or component that I didn't 
make.

When this occurs, most likely Merchant Desktop is configured 
so that you automatically receive updates from the 
administrator. To avoid this, clear the Use Default check box (the 
"default" is any change the administrator makes). You must do 
this for each parameter that you do not want to be updated. If 
later you do want the administrator updates, select the Use 
Default check box.

If the Use Default check box does not appear on your screens, 
the administrator has turned that option off.

The administrator made some changes to the 
view, screens, or components, but I didn't 
receive the changes.

Check the settings for the Use Default check boxes. For each 
parameter, you can receive updates from the administrator only 
if the check boxes is selected.

If the check boxes are selected, try quitting all of the open 
browser windows and then logging in to Merchant Desktop 
again.

I hid the title bar on a component. How do I get 
it back?

If the pencil button is not available, you must ask an 
administrator to do this for you.

To show a hidden title bar:

1. For the screen that contains the component with the hidden 
title bar, click the screen tab and corresponding pencil 
button.

2. On the Screen Personalization screen in the graphic of the 
screen layout, click the pencil button of the component 
whose title bar you want to show.

3. On the component personalization screen, select the Show 
option and click the Save button.

4. On the Screen Personalization screen, make any other 
changes necessary and then click the Save button.

The screen appears, and the title bar is back on the 
component window.

I can't scroll to all of the prompts on the 
Top/Bottom screen

If you have a scroll wheel on your mouse, use that to scroll 
down on the screen. Otherwise, use the horizontal scroll bar to 
scroll to the right until the MicroStrategy vertical scroll bar 
appears.

Only one of my fading news feeds shows news, 
but the other one is blank

Replace one of the fading news feed components with a 
different news feed display, such as static. Currently, you can 
have only one fading news feed per screen.

I clicked a tab and the screen components are 
taking a long time to load, but when I click a 
different tab to go to another screen, that screen 
won't appear

This situation can occur when the screen you are accessing has 
multiple MicroStrategy reports and/or graphs. Sometimes you 
must wait until the reports or graphs have loaded before you 
can navigate to another screen.
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My password is no longer working Passwords are case-sensitive, so make sure that the Caps Lock is 
off. In addition, if the administrator has changed your password 
or user name recently, it's possible that Internet Explorer is using 
the wrong stored password. This can occur when the only 
change in the user name or password is case. 

Everything was working fine, but then I clicked 
a link and this message appeared:

This page cannot be displayed

When this message appears, quit the browser and then start it 
again and access Merchant Desktop. If that does not solve the 
problem, the server may be down. Inform the administrator.

A MicroStrategy log on screen appears instead 
of the reporting screen, and when I attempt to 
use the log on screen, nothing happens.

This can occur in the following circumstances: 

■ The MicroStrategy Intelligence Server and Web Universal 
application are not available.

■ The password you are using is invalid, or your user name 
and password are not in the MicroStrategy users database.

In both of these cases, notify the administrator.

The following Job Expired message appears 
when I attempt to access a report or graph:

The results for this report are no longer 
available. Please submit the request again.

This is a MicroStrategy error message. When it occurs, click the 
Re-Execute Report button. Typically the report will update 
when you click this button.

Accessing the Reporting screen or any screen 
that contains a report or graph takes a long time. 

The slow access time should occur only the first time you access 
reporting. All subsequent times should be much quicker.

The following message appear when I am using 
MicroStrategy, particularly the Top/Bottom 
screen:

The Web Server encountered an unknown 
runtime error.

This is a MicroStrategy error message. When it occurs, click the 
Top/Bottom tab in the Merchant Desktop view. This refreshes 
the screen, and you can then select your filters and execute your 
report.

When a graph first appears, it fits in the 
component window, but when I drill down or 
navigate to a different page, the graph becomes 
larger than the component window. 

This is a known issue with the MicroStrategy Web Universal 
application. When it occurs, you must navigate to a different 
screen and then back to the screen that contains the graph.

If you find this happens too frequently, ask the administrator to 
place the graphs in larger component windows. In some cases, 
you might even want one graph per screen, depending on the 
complexity of the graph.

I drilled down through a graph or report, but 
now I can't drill back up.

In MicroStrategy reports and graphs, there is no way to drill 
back up. Instead of re-executing the graph or report, 
MicroStrategy recommends using the browser back button.

Some folders in the Selected Report or Selected 
Graph tree won't close.

You cannot close the folder (or the parent folder) that contains 
the selected report.

I want to select a report or graph for one of the 
report or graph components, but there are no 
folders under the Please Select a Report folder.

This occurs when the MicroStrategy Intelligence Server and Web 
Universal application are not available. It can also occur when 
your user name is not in the MicroStrategy user database. Notify 
the administrator.

I want to change the type of layout of a screen 
but can't find a way to do it in the user interface.

It is currently not possible to change the layout of a screen. 
Instead, you must create a new screen.

For components in open layouts (i.e., 1-, 2-, and 
3-column), very large height parameters cause 
unpredictable window sizes.

Ultimately, the effects of height and width are controlled by the 
browser, not by Merchant Desktop. If the browser window 
sizing is not working as you expect, try decreasing the height of 
component windows.

Table 4–31 (Cont.) Troubleshooting for Merchant Desktop

Problem Solution
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Good Practices
This section describes the following recommended practices:

■ Copy the Sample Views, Screens, or Components

■ Lock Views, Screens, or Components until You Are Ready to Share Them

■ Test Your Views, Screens, or Components with Test User Accounts

Copy the Sample Views, Screens, or Components
If there is more than one administrator using Merchant Desktop, copy the sample 
views, screens, or components instead of making changes directly to them. (All 
samples begin with a “pl  - ” prefix.) This preserves the original sample views, screens, 
and components for all other administrators.

For example, the samples are available to all administrators by default. Thus, if you 
and a few other administrators happen to edit the same screen at the same time, only 
the last-saved version is preserved. Therefore, it is possible for your changes to be lost. 
You can avoid this scenario if you copy and rename samples before making changes to 
them

Lock Views, Screens, or Components until You Are Ready to Share Them
When you copy a sample or create a new view, screen, or component, make sure that 
the Allow All Administrators To Access check box is not selected (this is the default). 
As long as that check box is not selected, other administrators cannot see or change 
views, screens, or components that you have created. This is helpful when you are in 
the process of setting up views, screens, and components.

When you are finished setting up your views, screens, and components and you want 
to share them with other administrators, simply make a copy first and then select the 
Allow All Administrators To Access check box. Your original copy is then preserved 
but other administrators can still access the views, screens, or components that you 
want to share.

Test Your Views, Screens, or Components with Test User Accounts
It is recommended that you assign the sample views to a test user account rather than 
to your own account. As an administrator, you have special privileges that standard 
users and power users do not have, and this can affect the functionality of the view, its 
screens, and its components. When you log on with a test user account, you can see the 
view exactly the way that users will.

■ To create two user accounts (e.g., one standard user and one power user) for 
testing purposes, see Creating a User Account.

■ To assign a view to a test user account, see Assigning a View to a User.
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